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1 Notes on documentation

These instructions are aimed at administrators and users who are familiar
with the installation and the operation of the software. Read these operating
instructions prior to commissioning and be sure to keep them accessible for
later use. Rittal can accept no liability for damage and operating problems
resulting from non-compliance with these instructions.

1.1 Retention of documents

These instructions and all other applicable documents constitute an integral
part of the product. They must be given to the administrator. The device
operator is responsible for the storage of the documents so that they are
readily available when needed.

1.2 Used symbols and technical terms
The signal word classifies the effects of a danger in case of non-observance
of the safety instructions.
e Note
Identification of the situations that can lead to incorrect
configurations or material damage.

The signal words are shown in the following form in the instructions:
e.g.

Signal word!
1. Description of the danger and its
effect

2. Description of the behaviour of the
user to prevent danger




2 Commissioning RiZone

RiZone is offered as Appliance and as Software Appliance. The
Commissioning chapter describes the commissioning of both variants.

2.1 Commissioning the RiZone Software Appliance

The commissioning of the Software Appliance requires a hypervisor. The
format of the virtual hard disk is not the same between platforms. The
following virtualisation solutions are supported: VMware Server and ESX(i),
Xen and Microsoft Virtual Server. The RiZone Software Appliance
requires 4 GB RAM, 70 GB hard disk and two CPUs with more than

2 GHz as resources. Because of the large dependency between the speed
and the availability of the network interface, we recommend that the
Software Appliance is given its own network card.

The RiZone Software Appliance is started from the management tool of the
virtualisation platform. The RiZone GUI is not yet available after booting.
For a detailed description of the integration of the virtual hard disk in the
virtualisation platform, please consult the virtualisation manufacturer's
documentation.

22 Commissioning the RiZone Appliance

The installation is performed in accordance with the hardware
manufacturer's specifications. After switching on the Appliance, the server
will boot. The required services start automatically. The system is ready.

23 Commissioning RiZone

The login to the RiZone server is made with the standard user
Administrator and the password "RiZ0ne!!". We recommend that you
change the password after the first login.

RiZone is supplied with the English keyboard layout. If necessary, change
the keyboard layout after the first login.

2.3.1 Configuration of the server name, work group, domain

The configuration is made with the Windows Server 2008 R2 operating
system. The computer name as delivered has the name RiZone1-3. If the
computer name is changed, a new certificate for RiZone must be created.
The certificate is created with an additional program. This program is
available on the server at C:\rizone_install\RittalSSLCfg.exe.

RiZone
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Iﬁ{ C:\rizone_installRittalSSLCfg.exe
Rittal RiZone S5L Configurator

[D] Development Certificate {(localhost)
[P]1 Production Certificate (DEB2ZHERG673781NB>

Your choice: P_

Fig. 1 Creating a certificate

P (a capital letter must be specified) selects the creation of a certificate for
productive operation. Press the Enter key to confirm the selection. This
creates the certificate.

2.3.2 Network cards configuration

The network setting is configured from the Windows Server 2008 R2 server
operating system. Customise the network setting to your network using Start
> Control panel > Network and Sharing Center.

If the IP address has been changed successfully, the trap receiver for
all devices monitored with RiZone must be modified manually.

IP V6 is disabled in the delivered state.

2.3.3 Configuration of the Fully-Qualified Domain Name (FQDN)

If necessary, the FQDN is changed from System properties (system) >
Computer name > Change > More. This configuration is not necessary if
the RiZone server is a member of a directory service or the NetBios name of
the RiZone server can be resolved.

234 NTP server configuration

All components of the RiZone installation must be operated synchronously.
If the RiZone server is member of a directory service, the NTP server does
not need to be configured because the directory service makes this
information available.

The NTP server is configured manually in the operating system using the
Change date/time function.

235 Database backup

RiZone has its own internal Microsoft SQL Express database. This database
is compressed and backed up once per day. The operation of RiZone
requires that the database backups are deleted regularly from the RiZone
server. The backups should be stored on an external backup medium. The
retention time must be changed appropriately depending on the customer
requirements.

No local backups will be created if RiZone is operated with an external
database.

As supplied, RiZone operates with a Microsoft SQL Express edition. The
size of a single database is limited to 4 GB.



Caution!
Ensure that the databases and drives
d have sufficient free capacity.

To ensure the reliable operation of RiZone,
the free storage space on the RiZone
server must be checked in regular
intervals. The C:\ drive contains the RiZone
log files in the \Program Files(x86)\Rittal\
RiZone folder and the SQL server log files
in the \Program File\Microsoft SQL
Server\MSQL10.SQLEXPRESS\MSQL\Log
folder.

The D:\ drive provides the storage space
for the database.

The E:\ drive is the backup drive for the
database.

Old messages and values (Float, Int, String) are deleted automatically from
the database after 30 or 90 days. The number of days after which messages
or values are discarded can be set in the %APPDATA%\Rittal\RiZone\Datal\
MetaData\Configurations\DataDBConfig.xml file using the two parameters
<DaysAfterMessagesGetDeleted> and <DaysAfterValuesGetDeleted>. If
these parameters are not set, the standard values of 30 days for messages
and 90 days for variable values will be assumed. Setting the parameter to 0
deactivates the automatic deletion.

The database backups are stored in the drive of the SQL instance.

If RiZone is connected to an external database (MS SQL or Oracle), the
database backup must be performed there.

2.3.6 Updating the RiZone Appliance

If you have completed a service contract, you will receive updates for RiZone
from our Rittal Service International department (e-mail: service @rittal.de,
Tel.: +49 (0) 2772 505 1855).

RiZone
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3 Installation of the RiZone GUI

The RiZone GUI is installed locally on the client PC. As prerequisite, the
Microsoft .NET Framework 4.0 SP1 must be installed. The .Net Framework
is available at the following URL:
http://www.microsoft.com/download/en/details.aspx?id=17851

The installation file of the RiZone GUI is located in the C:\rizone_install\ path
on the RiZone server. The RiZone administrator must make available the
installation file.

3.1 Installing the RiZone GUI
The Rittal.RiZone v2.xGUl.msi MSI package must be available on the local
client PC. A double-click executes the file.

i@ Rittal RiZone ¥1.0 GUI Setup =101 %

Welcome to the Rittal RiZone v1.0 51
Setup Wizard

The Setup Wizard will install Rittal Rizone v1.0 GUT on waur
computer. Click Mext to continue or Cancel ko exit the Setup
Wizard,

Bk I Mexk I Cancel

Fig. 2 Installing the RiZone GUI

Click the Next radio button to perform the RiZone installation.

{& Rittal RiZone ¥1.0 GUI Setup ]
End-User License Agreement
Please read the Following license agreement carefully
Jtandard Terms and Conditions for the sale of ﬂ
SJoftware

of Rittal GmkhH & Co. EG

1. General Terms

The following standard terms and conditions shall
govern all our sales and licensing of software. They
also apply in relation to any product particulars

set out in brochures, price lists, advertisements,
internet sites and similar media. Any standard terms
and conditions used by the Purchaser which conflict LI

IV 1 accept the terms in the License Agreement

Print: | Back I Mext I Cancel

Fig. 8 Installing the Rizone GUI

The licence conditions must be accepted and Next clicked to continue the
installation process.



{3 Rittal RiZone v1.0 GUI Setup =101

Destination Folder
Click Mest to install ko the default Folder or click Change ko choose another

Install Ritkal RiZone v1.0 GUT ko:

IC:\Pmgramms\R\ttal\R\Zune_v1 W

Change...

Back I Next I Cancel

Fig. 4 Installing the Rizone GUI

The target directory can be changed. The preset target directory is:
C:\Programme\Rittal\RiZone\
Click Next to continue the installation process.

ii§4 Rittal Rizone ¥1.0 GUI Setup ;IEIEI

Ready to install Rittal Rizone v1.0 GUI @

Click Install ta begin the installation. Click Back ko review or change any of your
installation settings, Click Cancel to exit the wizard.

Back I Install I Cance

Fig. 5 Installing the RiZone GUI

Click the Install button to continue the installation process.

ii‘vz,! Rittal RiZone ¥1.0 GUI Setup ;IEIEI

Completed the Rittal RiZone v1.0 GUI
Setup Wizard

lick the Finish button to exit the Setup Wizard.

Eack I Finish I Caric]

Fig. 6 Installing the Rizone GUI

Click Finish to complete the installation. A link to the RiZone GUI is now
present on the desktop and a link is available at Programme\Rittal.
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4 Licensing
RiZone's licensing concept provides a high flexibility matched to the needs of
the end user. The licensing is made using the following criteria:

e The number of IP nodes to be monitored

e  The number of concurrently logged-in users

e Additional functions (SCOM connection, SNMP agent)
The input of the licence key activates the licensed functions. An unlicensed
RiZone Appliance has the functional scope of RiZone Light.

Model No. Designation

7990.205 RiZone volume licence for 10 IP nodes

7990.305

7990.206 RiZone volume licence for 25 IP nodes

7990.306

7990.207 RiZone volume licence for 50 IP nodes

7990.307

7990.208 RiZone volume licence for 100 IP nodes

7990.308

7990.209 RiZone volume licence for 250 IP nodes

7990.309

7990.012 Microsoft SCOM Management Pack

7990.101 RiZone Server Appliance

7990.201

7990.301

7990.103 RiZone Server Software Appliance

7990.203

7990.303

7990.014 SNMP support for third-party devices
4.1 Querying the licence status

The Administration > Licence entry displays the customer number, the
licence key, the instance number and all licensed functions.

4.2 Functional restriction of RiZone Light
RiZone Light supports the following components:

e 10IP nodes

o 1 client access licence

o UPS, single-phase

¢ CMC-TC, incl. LCP Standard

4.3 Input of the licence key

The Administration -> Licence menu can be used in the dialog to enter a
licence key.

If no code is entered, the server operates in RiZone Light mode.

The RiZone licence key is entered in conjunction with the customer number
and the instance number. Once the licence data has been entered, Check
must be clicked to check the input. The licensed functions will be shown in
the licence window.

11
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4.4 Exceeding the licensing for RiZone

The user adds an additional device from the Discovery. No licence check is
made when the project is created. This check is done only when the project
is uploaded to the server.

When the project is uploaded to the server, the following message appears
in the message window: The number of project nodes exceeds the
limitation. The project was not uploaded.

4.5 Configuring of unsupported devices for RiZone Light
The user adds an additional device from the Discovery. No licence check is
made when the project is created. This check is done only when the project
is uploaded to the server.

When the project is uploaded to the server, the following message appears
in the message window: The project contains devices that are not
compatible with RiZone Light. The project was not uploaded.

4.6 Exceeding the licensing of the logged-in clients

When a user is logged in to RiZone, a check will be made whether sufficient
client access licences are present. If the maximum number of licences is
reached, the following message will be issued:

The number of concurrently used clients is exceeded.

RiZone
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5 Login mask

The RiZone server must be registered before the first login to RiZone is
made. The registration installs a certificate for the encrypted communication
from the server and the GUI on the client PC.

Important!
The certificate must have been created
once previously on the server. For

details, see Chapter 2.3.1.

5.1 Registering a RiZone server

Prior to the registration of a RiZone server, it must be guaranteed that the
server can be accessed from the client PC. The accessibility can be checked
with the Ping command from the command line of the operating system. If
the Ping command is performed successfully, the registration of the server
can be performed.

To register the RiZone server, the RiZone GUI is opened. If a server is
already registered in the GUI, the server will be shown in the server selection
box. A server is registered from the Others menu item.

Server D anderer
- Benutzer RiZoneViewer -
e (m—— . RiZone

| German (Germ - |

Fig. 7 Registering a RiZone server

The login mask opens a second window that permits the registration of a
server. Several servers can be registered.

Fig. 8 Registering a RiZone server

The name of the RiZone server is entered in the Host input field. If the
RiZone server cannot be reached, a tooltip will appear when the OK button
is clicked and an exclamation mark indicates the Host menu item.

Host riztraing

Fig. 9 Registering a RiZone server
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When the registration of the RiZone server has been performed successfully,
a message window will open that informs about the download of the
certificate. This message must be confirmed with Yes. After the confirmation,
the login mask opens.

Server © anderer
n Benutzer FiZonzViewer .
; - : RiZone

Fig. 10 Registering a RiZone server

5.2 Login process

The RiZone GUI is started on the client PC. The RiZone login window opens.
The RiZone server can be selected in the selection box. If no server is
offered for selection, a RiZone server must be registered (see Section 5.1).
For the first login to the RiZone server, the user is preassigned with
RiZoneAdmin. The standard password for the RiZoneAdmin is: RiZOne!! We
recommend that you change the password before the first login.

5.3 Changing the password

The RiZone GUI is started on the client PC. The RiZone GUI login window
opens. The RiZone server can be selected in the selection box.

The user's password is changed by clicking the Change menu item next to
the Password input field. A second window opens in which the old password
and the new password (twice) must be entered.

Benutzer | RiZoneViewer |

__ i 1 RiZone

Abbrechen

Fig. 11 Changing the password

The password for RiZoneAdmin must be at least seven characters
(alphanumeric) long and contain a special character and both uppercase
and lowercase characters. Once the password has been changed
successfully, the login dialog opens.

If an unsafe password has been selected, a message text will appear in the
window.

Benutzer RiZoneViewer

Abbrechen

Fig. 12 Changing the password
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5.4 Selecting the GUI language
The GUI language is selected at the login to RiZone. If the GUI language
differs from that of the operating system, all RiZone message boxes use the

language of the operating system.

Server lrictaing -] © anderer

Benutzer ~ RiZonsViewer

HEELENA AN

English (United Stzta"k

Fig. 13 Selecting the GUI language
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6 RiZone user interface

6 RiZone user interface
This chapter provides an overview of the most important subareas of the

RiZone user interface.

The RiZone user interface has two different modes, the admin mode and the
view mode. You reach the admin mode only when you are logged in as user
with administration rights. The user must be in admin mode to create new
projects or edit existing projects. In view mode, the current RiZone project
can be monitored only. Depending on the user rights, components can be
controlled and device configurations changed from within RiZone.

=4 RiZone [Benutzer=RiZoneAdmin, Server=rz-xen-t1, Modus=Admin]

Projekt Bearbeiten Ansichten Charts Workflows Berichte  Administration Hilfe 1
= N A I
— =
Standorie [ Geréte ] [791] RimatrixDemo : Variablen 2 % ]
a8 5 Lo [¥]Gruppieren  Variablz suchen: l:l 4
= ] Deutschiand 3
=] "JHerbUm D Name Typ Wert Einheit Intervall Veroffentlichen Pfad Eindeutige 1D Verbindungs ID  Gewerk  Bedeutung  Phys. Mess
[=] m Empfang 752 MonitoringStatus  StatusInt off False 0 State Undefined
h 753  CoclingStatus StatusInt off False 0 State Undefined
= [ showroom 794 SecurifyStatus  StatusInt off False 0 State Undsfined
=] 785 AvailabilityStatus  StatusInt off False 0 State Undefined
Ilm Schrankt 796 PowerStatus StatusInt off False 0 State Undsfined
787 TotalStatus StatusInt off False 0 State Undsfined
Ilﬂ] schrank2
v schrank1
ll;u Schrank3
CE»[Q[ ~ | Schrank2
Leakage Sansc ) Schrank3
B} LeF 1.3
m P22 v C5-121
i Lcr23 i~ Leakage Sensor
385 Typs Statusint 300 False 1.3.6.1.4.1.2606.4.2.3.5.2.1.2.2 protocol(snmp)/device 4 ﬂ State
350 Text String 300 False 1.3.6.1.4.1.2606.4.2.3.7.2.1.2.2 protocol(snmp)/device 4 Configuration
351 Status StatusInt 300 False 1.3.6.1.4.1.2606.4.2.3.7.2.1.3.2  protocol(snmp)/device 4 _Eh & State
v LCP1.3
v) LCP2.2
v LCP2.3
< >
Aktuelle Meldungen [Ahgmluﬂene Meldungan]
)
Kategoriefilter auf aktuslle Liste:  alle Kategorien von aktusller Liste anzeigen - | Zeitspannefilter auf akiuelle Lists:  Alle - | O =
- 2 Zeitpunkt Zeitraum Prozess Eigentimer Status Beschreibung
5

Fig. 14 RiZone user interface
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1 | Drop-down main menu

2 | Toolbar (refer to the toolbar explanation)

3 | Tabs for project trees

Locations tab: Project tree for the location structure. The components
are represented in accordance with their physical arrangement.
Devices tab: Project tree of all SNMP components. The components
are represented in accordance with their technical arrangement.

4 | View window: Variable values and graphical evaluations are shown here.
If several views are called, it is possible to switch between these using
the tabs at the top of the View window.

RiZone
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5 | Properties window of the components
The properties of the components selected in window 2 are displayed.

6 | Status window

The current status messages appropriate for the currently selected
action are output here.

Toolbar explanation

1. ] New project (active only in admin mode)
Creates a new local project. To activate the project, it must be
uploaded to the server.

2. ek Open project (active only in admin mode)
Opens a project file on a drive and loads it to the client. To activate
the project, it must be uploaded to the server.

3. e Save project (active only in admin mode)
Saves the project currently open in the client to a drive.

4. - Upload to server (active only in admin mode)
Uploads the project currently open in the client to the server and
activates it there immediately. Important: The project currently
present on the server will be overwritten.

5. W” Start project (active only in admin mode)
The client changes to the view mode and then shows the current
and historic data collected by the server. The project used here is
that what was most recently uploaded to the server.

6. ‘% Download from the server (active only in admin mode)
Downloads the current project from the server to the client. The
project on the server remains active. Any changes made previously
in admin mode will be discarded.

7. s Discover (active only in admin mode)
Opens the discover window.

ﬁ
8. =& Configure project (active only in view mode)
The client changes to admin mode. The project can be edited here
(discover, add or remove components, create charts, etc.).

17
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7 Creating a new project
To create a new project, the user must be logged in as RiZone administrator.

71 Creating a new project
To create a new project, first click Project > New project or click the New

project J icon, specify a name for the project and confirm by clicking OK.
The newly-created project now appears in the left-hand side of the RiZone
window.

For configuring, the existing infrastructure must first be created in a tree
structure below the project name (root node).
To do this, select the Locations tab in the left-hand subwindow.

Then right-click the Root node = and select the Add item from the
opened context menu. Select here the required component from the
Location, Building, Room, Enclosure Suite and Enclosure infrastructure
components, assign a meaningful name and a description. After clicking OK
to confirm, the new component appears below the root node.

Add additional components similarly until the infrastructure of your data
centre is represented in the project tree.

Drag & drop can be used to subsequently assign created components to
other components. Only logical moves, however, are possible here (e.g. a
room cannot be assigned to an enclosure).

The context menu of the infrastructure components also contains the
Expand tree and Collapse tree items. These items are used to open or
close the complete tree structure below the selected node.

Please also note the functions 7.4.2 Copy components and 7.2.1
Autodiscovery of the SNMP components (multiselect functions), because
they are very useful for creating a complete project tree.

7.2 Entering the SNMP components in the network
After the base project tree has been created, it must be populated with the
components to be monitored actively.

7.21 Autodiscovery of the SNMP components

Active Rittal components in the network that support the SNMP protocol can
be acquired using the Autodiscovery function and then added to the project
tree.

ot 4 . .
Select from the Edit > Discovery drop-down menu or click the .1 icon in
the toolbar.

The discovery window then opens.

RiZone
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RiZene - Entdeckung

izerdte

Optionen

SNMP ]

Discovery [¥]
Protocol | SNMP

Start-IP 10 20, 49 .

StopIP | 10 . 201 . 49 . 255

Custom Dewice

SNMPv1
ProtocolVersion SMMPv1
SnmpReadCommunity public
SnmpWriteCommunity bublic

Rittal CMC

SNMPv1
ProtocolVersion SMMPv1
SnmpReadCommunity pulblic
SnmpWriteCommunity public

Start ZLuriicksetzen | | SchiieBen

Fig. 15 Discovery

Parameters in the discovery window

Discovery | The Discovery checkbox activates the selected protocol for
the discovery process.

Start-IP RiZone begins with the search for Rittal SNMP components
starting at this IP address.

Stop-IP RiZone begins with the search for Rittal SNMP components
ending at this IP address.

Custom If a search should be made for third-party SNMP devices,

Device the appropriate read/write communities must be entered in
the following two fields.
Please note: To access SNMP devices from third-parties,
a driver must have been created previously using the
RiZone 7990.014 supplementary module. Also refer to
Chapter 7.3.

SNMPRead | Read community that contains the SNMP components

Community | (default public).

SNMPWrite | Write community that contains the SNMP components

Community | (default public).
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Rittal CMC | If a search should be made for Rittal SNMP devices, the
appropriate read/write communities must be entered in the
following two fields.

SNMPRead | Read community that contains the SNMP components

Community | (default public).

SNMPWrite | Write community that contains the SNMP components

Community | (default public).

Once the parameters have been set correctly, click Start to start the

automatic discovery function.
RiZone now searches for active Rittal components in the specified address
range. A list with the devices supported by the current release can be found
in the Release Notes for the appropriate current version on

www.rimatrix5.com (Service&Support > Downloads > Software area).

After completion of the discovery (100%), all discovered components will be
found under Devices.

Fione - -ntdeckung [=]
Gerate Optionen
LKS System SNMP |
o LKS System =
d bl Discovery [¥]
=12 SRR
£s 1‘,_ fC 00— FOLAT (253 rad Pratocal | SHNMP
Imd PU2 - Entwicklung 1 Ctatgp | 10 - 01 . 49 . 1
Stop-P | 10 . 0L . 49 . 255
Custom Device
SHMP1
ProtocolVersion SHMPVL
SnmpReadCommunity public
SnmpWriteCommunity public
Ritlal CMC
SNMP/1
ProtocolVersion SNMPv1
= - SnmgReadCommunity public
= SnmpWriteCommunity public
| Stopp || Zuricksetzen || SchlieBen
Entdeckung luft — ] 21% 100%

Fig. 16 Discovery with discovered components

A\

Important!
If for the deployment of two
communications modules not all

devices are found during the

discovery, check the IP address
ranges that you have set for the
modules.
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A click on the plus sign in front of a component shows additional

subcomponents (e.g. sensors).

From the device list, the components in accordance with their arrangement
in the data centre can be moved with drag & drop into the Locations project

tree.

Warning!

All components must be selected individually.
A/ E For example, the selection of a PU does not

automatically include the selection of the

associated connected components.

Multiple components can be selected with multi-select and then moved. The
order of clicking determines the order of the display in the tree after

dragging.
Multi-select functions:

Ctrl + left mouse button

Select individual components

Ctrl + A

Select all components

Shift + left mouse button

Mark from the previously selected
component through to the new component

Shift + up/down arrow

Mark from the previously selected
component through to the component
above/below

Ctrl + Plus Expand all components starting at the
(main keyboard) currently selected node

Ctrl + Minus Collapse all components starting at the
(main keyboard) currently selected node

Left/right arrow Expand/collapse the current node

* (num block)

Expand all subcomponents

+ (num block)

Expand the next level

- (num block)

Collapse everything below the selected
node

Components already assigned to a tree are marked light-blue in the

discovery list.

During the move to the Locations tree, the device also appears
automatically in the Devices tree, but not conversely. Components used
only in the devices tree but not in the locations tree can be transferred to the
locations tree with the Add to locations function.

To do this, right-click the component in the devices tree and then select Add
to locations. The component will then be added at the end of the project in
the locations tree from where it can be moved to any position in the project

with drag & drop.

The moving of components with drag & drop to another position in the
locations tree is always possible in admin mode.

If you want to update a component, perform the discovery of the component
again and with pressed Alt key use drag & drop to move the newly
discovered device to the component already present in the project. This
updates the data for this component in the project.
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7 Creating a new project

The list of the discovered devices can be deleted by clicking the Reset
button.

Projekt Bearbeiten Ansichten Charts Workflows Berichte Administration Hilfe
RANEA"™ N ENE A -

Standorte | Gerdte |

4 E Rittal-Showroom
a E_J Germany
4 E_J Hessen
- E_J Herbormn
4 E_J Stuetzelberg
4 ﬂ Showroom

b ] Rackl

4 W) Rackz
WjLcP 2.2
Temperature Rack 02
& Rackoz-A
&l Rackoz-B

b ] Rack3

E Rittal PMC 200 - 50W (3+1 red.)

Leakage Sensor

v BE] NRwW

Fig. 17 Project tree with Rittal components

Fig. 17 shows a project tree for which the discovered components have
already been added.

Basic configuring is completed once all infrastructure components have been
acquired and the active SNMP components added.
The project should now be saved with Project > Save project or by clicking

the lH icon.

Note!
The project can be saved only for the
selected project tree.

Before saving a project, a component
of the devices tree or locations tree
must be selected.
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7.3 Including third-party SNMP devices (MIB Browser)

To also query data for third-party SNMP devices (non-Rittal devices with
SNMP support), as of RiZone version 2.0, the "MIB Browser" function can be
used to generate your own driver templates. The function must be enabled
with an appropriate licence key.

The MIB (Management Information Base) of the third-party device must also
be available. You can normally download the MIB from the device
manufacturer's web page.

7.3.1 Creating drivers for third-party devices

In admin mode (configure project), new drivers for SNMP devices can be
created from the SNMP templates tab.

Projekt Bearbeiten Ansichten

arkflows Berichte Administration  Hilfe

5 el P8 e B et

Standorte | Gerate | SNMP-Vorlagen

M RittalRiZone

=1

RITTAL
Ll ]
Aktuelle Meldungen [ Abgeschiossene Melgungen |
Kategoriefilter auf aktuelle Liste  Alle Kategorien von aktueller Liste anzeigen  ~ Zeitspannefilter auf aktuelle List: Alle ~ | @ Vorherige Meldungen el
Zeitpunkt Zeitraum Prozess Eigentimer  Status Beschreibung
i 10082011 14:28:01 > 30 Min, Project 0 Meone Project with 61IPs and 936 Variables opened,

RiZone

Fig.17b SNMP templates tab

To create a new driver template, first click the Load SNMP templates
button, right-click the root node in the SNMP templates tab and select Add.
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Erstelle neus Vorlage

Pfad der MIE Datei

PheigeneDateien_Markus_Schmidt\Projekt\RiZon

Vorlagenname

nonRittal_UPY|

| Ok

Fig. 17¢c Creating a new SNMP template

In the dialog that now opens, select the file path for the MIB of the device
manufacturer and assign a name for the template.

Note!

/ MIBs that themselves contain
references to another MIB cannot be
used.

A two-part window now opens in the main area of the GUI. The device MIB
is displayed in a tree structure on the left-hand side.

Now open the tree structure and find those variables (OIDs) whose values
you want to query later from RiZone and use drag & drop to move them into
the right-hand field.

If tables in the MIB are used for a third-party device for which the index of
the table is not maintained, the exact OID in the table field must be added
from the RiZone MIB Browser.

You can obtain the complete OID, for example, with the help of an external
MIB tool (such as "iReasoning MIB Browser"). The table in the MIB branch
must be selected with the MIB tool. A "get bulk" can then be used to fetch all
table entries. When the appropriate variable of the table is now selected, the
complete OID will be displayed.

The OID is augmented in RiZone in the "Table Rows" window of the RiZone
MIB browser. An additional "HowTo" in PDF form is available on our web
page www.rimatrix5.com (Service&Support > Downloads > Software area).
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MIB-Browser - nonRittalUPS % % ]

e s

4 internet (1.3.6.1) : olin} Name
directory (1.3.6.1.1) 13612133130 upsinput
4 gt Al | 13612133140 upsOutput
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upsldentName (1.3.6.1.2.1.33.1.1.5)
upsldentAttachedDevices (1.3.6.1.2.1.33.1.1.6)
upsBattery (1.3.6.1.2.1.33.1.2)
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upsConfig (1.3.6.1.2.1.33.1.9)
4 upsTraps (1.3.6.1.2.1.33.2)
upsTrapCOnBattery (1.3.6.1.2.1.33.2.1)
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| Treiber speichern |
Fig. 17d MIB browser with opened MIB

LY

If you want to delete a variable from the right-hand window, you can do this
with a right-click > Delete.

Note!

You can obtain the description of the
MIB and the meaning of the variables
from the device manufacturer.
Because of the large number of
available SNMP devices, Rittal cannot
provide any information about specific
MIBs.

Once you have moved all required variables into the right-hand window, you
must now specify the details of the variables in the right-hand window. For
details, consult Chapter 7.3.3.

The driver must now be saved and loaded to the server. This is done by
clicking Save driver.
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Varlagenname nonRittal_UPS

Enterprise OID 136.14.1.34274

Bedingungzbeschreibung (beginnt mit)
Gerdtz (durch KEamma trennen)

Werden Massenzabfragen unterstitzt?

|' Ok

Fig. 17e Driver details
Further data is required before the driver template can be saved.

e Template name
The name of the template with which it will be stored later on the
server must be specified in this field. The template name must
conform to the general code conventions. This means, the name
may contain only alphabetic characters (A-Z, a-z) and digits (0-9),
and must start with an alphabetic character. Underscores are also
permitted. If the input does not satisfy the specifications, the field will
be displayed with a red frame and the OK button will be greyed-out.

e Enterprise OID
During the discovery action, the Enterprise OID of the driver will be
compared with the "sysObjectID" variable of the device. Only when
the Enterprise OID specified here matches that in the device can a
device be found during the discovery action.
Although RiZone normally automatically fetches the Enterprise OID
from the MIB, it must always be checked again. If the ID is not
fetched correctly, you can normally find the sysObjectID
(=EnterpriseQID) in the "private" branch or in the "mgmt >mib-2 >
system" area of the MIB.

e Condition description (begins with)
In addition to the Enterprise OID mentioned above, a comparison is
also made with the value in the "sysDescr" SNMP variable.
However, the variable value does not need to be specified here, but
only the start of the character string. A case-sensitive character
comparison is made. The description only needs to be specified
when several templates should be created for an MIB.

e Devices (separated by a comma)
Character strings to which devices the driver is assigned can be
specified in the Devices field. This input is used only to display the
device information in the Properties window. Each individual device
detail is separated with a comma.

e Are bulk queries supported? (bulk query SNMP)
This checkbox should be activated only when the associated device
can supply all configured variable values by bulk query.

Once at least the Name and Enterprise OID fields have been completed, the
driver will be created automatically and loaded to the server when OK is
clicked. The driver template also appears in the template tree structure in the
SNMP templates tab.
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7.3.2 Including third-party SNMP devices in the project

Once the driver has been created, third-party devices can be found with the
discovery function and transferred to the project (locations or devices tree).
See Chapter 7.2.

7.3.3 Third-party SNMP devices - variable details
Variables found with SNMP templates and included in the project differ from
the details of a Rittal device.

You find the variable details of a third-party device variable when you have
already moved variables into the right-hand window of the MIB browser.
Double-click on the variable to be edited.

Variablendetails definieren @
oID 1361.2.1.33.1.20
Mame upsBattery
Datentyp | String - |
SNMP-Datentyp |CCTET_STRING |
Schreibzugniff
Anzeigetyp | TYPE_ASCIL XSS STRING = |
Beschreibung .
Intervall llﬂ - |
Bedeutung [‘u"alue v|
Einheit

Anzeigefaktor 1

Anzeigeformat

Faktor 1

Ok |

Fig. 17f Variable properties for third-party device variables
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Variable Description

property

oID Object ID of the variable to be polled. It is determined by
moving the appropriate variable from the MIB tree.

Name The name of the variable displayed later in the variable
list. It must have a unique designation in the driver.

Data type RiZone-internal data type. It is used for the visualisation
and status evaluation of the variable.
Statusint -> Numeric value that RiZone should translate
as status.
Float -> Measured values and setpoints as floating-point
number
String -> Character string

SNMP data SNMP standard data types (INT, OCTET_STRING,

type OBJECT_IDENTYFIER). If possible, the SNMP data type

is initialised from the MIB.

Write access

The write access can be selected when a variable can
generally be written using SNMP. The RiZone
administrator has the capability here to further limit the
write rights of a variable.

Display type

The RiZone-internal type used to display the values. The
type defines the appearance and behaviour of the
Setting window of the variable.
TYPE_ASCII_XSS_STRING -> A string checked for
Cross-Site Scripting (security mechanism to prevent
infected source code from being imported). When this
display type is selected, Minimum and Maximum define
the minimum and maximum character length,
respectively. If it should be possible to set the value,
these must be specified appropriately.

TYPE_FLOAT -> Set a floating-point value
TYPE_PASSWORD -> Passwords are displayed as
asterisks.

Combo-values are stored separated with a comma. The
first value is the selected default value; the various
selection possibilities follow.

Interval

The specification in which time intervals RiZone should
cyclically poll the variable. The time is specified in
seconds.

Meaning

The meaning defines the access to the variable.

The meaning is used to automatically assign the
appropriate right to the variable. State and Value are
assigned the "Read" right. Service is assigned the
"Configuration" right. The Set buttons are also created
using this setting: they are displayed only for variables
with the Setting, Configuration, Execute or Service
meaning and then only when the write access is
activated for this variable.

State -> The variable will be translated as status
variable. Integer values are translated to the OK,
Warning or Alarm status. If State is selected as meaning
in the combobox, three additional input fields appear for
the default values of the status translation. One or more
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unsigned integer values can be entered for each field.
The inputs must be separated with a semicolon or a
minus (input of a range).

Note: "String" must be selected as display type.

Value -> Values that can only be displayed (example:
text items or temperature values).

Setting -> Setting variables can be written from the GUI
to the SNMP device. If Setting is selected in the
combobox, limits must also be entered in the Minimum
and Maximum fields. These define the settable range
and the standard axis section for the chart. A step size
must also be assigned that specifies in which step
intervals the variables can be set (example: 0.5). This
type is assigned in the rights assignment to the Setting
right.

Configuration -> This type is assigned in the rights
assignment to the Configuration right.

Service -> This type is assigned in the rights assignment
to the Service right.

Execute -> This type is assigned in the rights
assignment to the Execute right.

Setting, Configuration, Service and Execute are
configurable variables in RiZone and are displayed with
the Set button provided the Write right has been
assigned. All other types are assigned the Read right.

Stepsize

This field specifies the minimum distance between the
values that can be set. It is used only when SNMP
values are also marked as settable. The distances can
be specified as Float number; that means, also contain
decimal places. This field does not have any effect on
the display of the values but only on the Setting dialog. It
is displayed only when the write access is selected and
Setting, Configuration, Service or Execute specified as
meaning.

Unit

The string that can be entered here is used to display in
which unit of measurement a value should be displayed
on the GUI. (Example: °C, V, kW, ...).

Display factor

The display factor specifies a multiplier with which the
data value stored in the database is converted before it is
displayed on the GUI. The factor can be specified as
Float number. The display factor is called Factor in the
variable list of the GUI. Example: convert power value
from W to kW with the factor 0.001.

Display
format

The format strings that can be specified here effect the
display of the values on the GUI.

Examples (value = 1000000):

0 — placeholder: 0:00.0000 — result: 1000000,000

# — digit-placeholder: O(#).## — result: (1000000)

. —decimal point: 0:0.0 — result: 1000000,0

% — percentage value: 0:0% — result: 1000000%

f — fixed-point value: 0:f — result: 1000000,00

Factor

The factor defines the multiplier with which the fetched
SNMP value is written in the database. It can also be
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specified as Float number.
Example: voltage value with one decimal place (230.2V
-> SNMP value 2302) -> specification factor: 0.1.

Minimum The minimum value for which settable values can be set
later by the user in a device via SNMP. For strings, the
value defines the minimum number of characters that
must be entered; for numbers, the minimum numeric
value that can be entered. For measured values, this
value defines the default entry for the smallest value
showed in the chart (Min-Y).

Maximum The maximum value that can be set. For strings, the
value defines the maximum number of characters that
may be entered; for numbers, the maximum numeric
value that can be entered. For measured values, this
value defines the default entry for the largest value
showed in the chart (Max-Y).

Group Classification of variables into a category of infrastructure
functions.

The following can be selected:

- Cooling

- Power

- Monitoring

- Security

The assignment to a functional area is of particular
importance for the evaluation of status variables.
Graphics change their colour depending on the status
only when the variable is assigned to at least one
functional area. The status value is also included in an
overall status of the functional area. The selection is
used and displayed only for status variables.

7.3.4 Deleting a template

A template can be deleted in the SNMP template tab. To do this, right-click
the template to be deleted and then select Delete in the context menu. The
subsequent delete prompt must be confirmed with OK.

Note!
After the deletion, no new devices can
/ be discovered using the template.
/ i \ After restarting the GUI, existing
devices in the project will also no
longer be displayed!

7.3.5 Changing an existing template

To change an existing template, right-click the template in the SNMP
templates tab and select Edit. The MIB associated with the driver and the
variables selected for the driver now opens in the main window. These
variables can now be augmented, changed or deleted. The driver must then
be saved again with Save driver.

The changes affect only those devices discovered after the change.

If the template name is changed when the save is made, a second template
will be created with the new name. The old template is also retained.
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Note!

Drivers must be unique. If a second
ﬁ driver should be generated from the

same MIB, the device assignment

must be made uniquely using the

"Condition description (begins with)".

7.3.6 Creating a template symbol for views
You can create for the created template a standard symbol that can be
added later to the views in the project and then behaves similarly as the
supplied symbols for the Rittal components.
To create a standard symbol, right-click the required template on the SNMP
templates tab and select Symbol.
The View editor now opens in which you can construct the standard symbol
from the following components:

e Polygons

e Variables

e Free text

The creation is performed similarly as the creation of a normal view (see
Chapter 8.6).

Once the symbol has been created, the editor must be closed with View >
Save view. A red exclamation mark now appears after the template in the
SNMP templates tab, because the template itself has not yet been saved in
the current configuration.

Save the template with right-click > Save.

7.3.7 Creating standard charts

The Standard Charts function can be used to create charts for the template
that are created automatically with each device moved into a project.

To create a standard chart, right-click the required template on the SNMP
templates tab and select Standard Chart.

The Chart editor now opens in which you can create charts similar to the
creation of a normal chart (see Chapter 9). Only the variable source no
longer needs to be selected with drag & drop. You have direct access to all
numeric and Boolean variables that have been defined in the template.

The standard chart must be saved with Charts > Save charts.

A red exclamation mark now appears after the template in the SNMP
templates tab, because the template itself has not yet been saved in the
current configuration.

Save the template with right-click > Save.
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Note!

If a standard chart is added subsequently to a driver,
the appropriate devices must be rediscovered and
with pressed Alt key dragged to the "old" devices.
To activate the chart, a new chart must be created
and edited. The standard chart settings can then be
accepted with "Charts > Load standard charts". This
procedure prevents an existing, individual chart from
being automatically overwritten by the default chart.
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7.4 Editing components
All functions listed here are available in Admin mode for RiZone.

7.4.1 Deleting components

Right-click the component to be deleted and select the Delete item in the
context menu.

The component will be deleted immediately from the view.

If a device is deleted in the Locations tree, it is still present in the project
and in the Devices tree. If, however, a device is deleted in the Devices tree,
it will also be deleted in the Locations tree. Calculations that contain a
variable of the deleted component will be deactivated. Both messages will
be displayed in the GUI message window.

7.4.2 Copying infrastructure components

Right-click the component to be copied and select the Copy item in the
context menu. Then select in the locations tree the infrastructure
components with a left mouse-click under which the copied component
should be added. Then right-click the component > insert. The previously
copied component now appears as copy under the previously selected
position in the tree. Note that only infrastructure components but no

sensors / active components can be copied with the function.

7.4.3 Transferring a component from the devices tree to the
locations tree

Components used only in the devices tree but not in the locations tree can

be transferred to the locations tree with the Add to locations function.

To do this, right-click the component in the devices tree and then select Add

to locations. The component will then be added at the end of the project in

the locations tree from where it can be moved to any position in the project

with drag & drop.

7.4.4 Counting IP nodes

The Number of IPs in the project function can be used to determine the
number of IP nodes used in the project. This is useful, for example, when
you want to add new devices to the project and want to check beforehand
whether the licence key provides sufficient free IP nodes.

To determine the used IP nodes, switch to the devices tree, right-click the
root node and select the Number of IPs in the project function. The
number of used IP nodes will now be displayed.

7.5 Starting a project
Before a project can be started, it must first be uploaded to the server. This

is done from the Project > Upload to server main menu or with the -
icon. The prompt whether the project should be uploaded must be
confirmed. The upload to the server has completed once the "Validation
completed, the project has been uploaded to the project folder" message
appears in the message list.

The created RiZone project will now be performed on the server and so all
active components also fetched using SNMP and any created workflows
performed.
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Project > Start project or 'J’ is used to switch the RiZone client to view
mode. The live data arriving at the server can be displayed in view mode. In
this mode, the user also has access to the historical values that have been
collected since the start of the project. These values, for example, can be
displayed using charts.

All project start messages are listed in the message list. The prompt whether
the project should be started must be confirmed.

7.6 Editing a project

If necessary, an existing project can be changed. To edit the project, the
user must be in GUI admin mode. The project can be downloaded from the
RiZone server or opened locally from the hard disk. The project is
downloaded from the Project > Download from server main menu or with

the 5 icon. The project can now be edited.

The original project will continue to run until the modified project has been
uploaded to the server. The editing of the project does not affect any other
users.
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7.7 Displaying values and variables

Once the project has been started, RiZone can be used to easily display all
available values that the individual components supply.

CMC-TC sensor example:

* Right-click the required sensor (locations tree or devices tree) in the
left-hand window.

e Select Variables in the context menu.

e The sensor variables will now be listed in the View window (right-
hand side). All acquired values (in Fig. 18, the temperature) and the
settings (SetHigh, SetLow, SetWarn) will be output.

| Projekt Bearbeiten Ansichten Charis Workflows Berichte Administration  Hilfe |
FIVETTTRENTYRN;
—
Standorte | Gerate [83] Temperature Rack 02 : Variablen & % ]
4 M Rittal-Showroom [C] Gruppieren  Wariable suchen:
- Ej Germany
| P E] Hessen ID MName Wert Einheit Gewerk W
| - Ej Herborn 68 Type Temperature sensor M
4 E] Stuetzelberg 70 Text Temperature Rack 02 Setzen|
4 wshowroom 72 Stab Ok aE
b i Rackl e
4 IEIJ Rack2 74 Value 24 °C
| iMLce 22 75 Setdigh 34 C (5etzen]
' 79 Setlow 10 °C |Set.zen|
B Rackoz-A s o
81 SetWamn 37 °C Setre
| B Racko2- =
I IIIJ Rack2 762 Service Active Setzen|
| | A Rittal PMC 200 - 60kW (3+1 red))
Leakage Sensar
« [B]nrw
Ej Dortmund
|
N
[-]Component
83
ez TEnfzaireize il Aktuelle Meldungen | Abgeschlossene Meldungen]
| | B Model number 7320.500
Component type Temperature Sensar
Description Kategoriefilter auf aktuelle Liste Alle Kategorien von aktueller Liste anzeigen - -
TET?eraMN (i3 LEEiE Zeitpunkt Zeitraum Prozess Eigentimer  Status .
Unit index 1 =
1 © 24.03.2011 14:24:07 Meonitoring 86 Nene 9
24.03.2011 14:24:.01 Monitoring 85 Nene g
Rittal_Sensor_Temperature © 24.03.201114:22:34 = 1 Min. Meonitoring 86 None g
Version 110 & 2403.201114:22:13 = 2 Min. Monitarina &6 Nene s
b Supported devices 7320500 < n | 2

Fig. 18 Output values in the started project
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If the variables of a higher-level component (e.g. room or enclosure) are
fetched, a list with all sensors, PSM busbars, etc. assigned to the component
opens in the View window. A click on the arrow in front of a sensor then
shows its values.

Projekt Bearbeiten Ansichten Charts Workflows Berichte Administration Hilfe

‘ Standorte | Gerdte | [[33} Temperature Rack 02 : Variablen # % l [698] Rack? : Variablen % %
« M Rittal-Showroom [¥] Gruppieren  Variable suchen:
a E] Germany
4 | Hessen 1D Name Wert  Einheit Gewerk 4
- E] ngbom 699 MonitoringStatus Ok
4[] stuetzetberg 700 CoolingStatus
« i Snowroom 01 SeeuiySlats Ok .
: gj Raackl 702 AvailabilityStatus Ok
| = 703 PowerStat Ok
| m ch 2"2 owel us
Temperature Rack 02 SN L
i Racko2- 767 Service Active Setzen
& Racki2-B ~| LCP2.2
I ' Q'JJ R?Ck"s ~ | Temperature Rack 02
| B Rittal PMC 200 - 60KW [3+1 red)
[ Leakage Sensor v Rack02-A
« [ nRw v Rack02-B
E] Dortmund

T EE D—

| \(2] 698 Aktuelle Meldungen | Abgeschlossens Meldungen ]
Narme Rack2
Description
Kategoriefilter auf aktuellz Liste Alle Kategorien von aktueller Liste anzeigen - -
Component type  RACK =) g bl s
Height 0 Teitpunkt Zeitraum Prozess Eigentiimer  Status
Width 0
D;_pth 0 Q@ 2403.2011 14:26:19 Monitoring 86 None g
Maximum Charge 0 v 2403.2011 14:26:08 Monitoring 85 None g
Cocling Capacity 0 @ 24032011 14:25:38 Monitaring 86 MNone g
Coninection Power 0 ¥ 24.03.2011 14:25:27 Ilanitarina ge Mene g
| -us 12 «| = | !

Fig. 19 Variables of an enclosure (Rack1)

The Monitoring, Cooling, Security, Availability and Power status variables
describe the status of the associated groups of this infrastructure
component.

TotalStatus provides the overall status of the infrastructure component over
all groups.

The Service variable can be used to set individual devices or complete
branches in the maintenance mode. Devices in maintenance mode are not
used to determine the status.
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7.8 Displaying values from the website

An alternative means of displaying sensor values involves calling the website
of the components.

A right-click on the component and the selection of Open website opens a
browser window in which the website of the component (e.g. CMC-TC
Processing Unit 1) is called.

Note!

The following functions are available
only when you are in admin mode.
Log in with a user who is member of
the RiZone administrators group.

Note!

Changes take effect only after the
project is uploaded.

Save the project and upload it to the
server.

> B

7.9 Creating a new variable

Variables can be created in RiZone. These variables are assigned to an
infrastructure component (e.g. room, enclosure, etc.).

A new variable is created by right-clicking in the variable view and selecting
the New variable in [location] item in the menu.

Input possibilities for creating a new variable

Name Name of the variable
Description Description of the variable
Type Float and Statusint are possible as variable type.

Float is used when a (float) numeric value is stored in
the variable, Statusint for status variables.

Important note: The variable type can be selected
only when the variable is created. A subsequent
change is not possible.

Publish If set, the variable will be passed to the Messaging
Service. The variable can now be fetched via SNMP
by a different system and the variable will be
transferred to SCOM, if the Management Pack is
activated.

Note:

The number of variables that can be transferred to
the SCOM is limited because of the interface of
the SCOM. A maximum of 100 variables or 10
variables can be transferred to the SCOM when
performance counters or SCOM SDK are used,
respectively!

Interval Specifies the calculation cycle (in seconds). Off
means that the variable will be calculated once after

the project is uploaded.
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Meaning The meaning of the variable (undefined, state, value,
setting, configuration, service, protected, execute).
"Value" should normally be selected here.

Physical Specifies the measurement quantity of the variable.
measurement

quantity

Unit Specifies the unit of the variable.

Display factor Display factor of the variable

Display format ,nim

where n specifies the number of digits before the
decimal point and m the number of digits after the
decimal point. Example: ,5:0.00 -> five digits before
the decimal point and two digits after the decimal
point.

Group Selection of the group of the variable.

The selection of the group affects the group status
variables of the component to which the variable in
the project is assigned. If the variable is assigned to a
group and changes its status, the group status
variable of the higher-level infrastructure component
also changes its status to that of the variable
(Exception: Another variable has already raised the

status of the group status variable to a critical status).

7.10 Editing a variable

Variables can be edited in RiZone. A variable is edited by being right-clicked
and the Edit variable item selected in the menu.

The variable name and the physical measurement quantity cannot be
changed.

7.1 Deleting a variable
Variables you created in RiZone can be deleted. A variable is deleted by
being right-clicked and the Delete variable item selected in the menu.

Note!
Only those variables you created
yourself can be deleted.

7.12 Calculating a numeric variable

RiZone can calculate variables. The four basic arithmetic operations,
brackets and Boolean algebra can be used as mathematical operators. Self-
created variables (Float type) can be used to link variable values
mathematically, for example, those supplied by sensors. The self-created
variables can then be used further within RiZone, for example, for display in
charts or in workflows.
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7.12.1 Selecting a variable

Only self-created variables of the Float type can be calculated. To select the
variable, the variable view of a component must be opened in admin mode.
A right-click opens the context menu of the variable and selects the
Calculate variable entry.

The Calculate <variable name> menu opens.

7.12.2 Selection of the component for calculating the variable

The component is selected using drag & drop. The component that contains
the variable required for the calculation is selected in the project tree. Drag
the component to the Component field in the variable calculation window;
you then have access to all available values of the component.

Note!
Only those components that contain
numeric variables can be selected.

7.12.3 Selection of variables

Once the component has been selected, all variables will be displayed in the
window. These variables are selected individually and with the Down arrow
button transferred to the variable list. Only numeric variables can be
selected.

7.12.4 Transfer of the variables to the formula field

A variable is transferred to the formula field by being marked with the left
mouse button and transferred to the formula field by copying the variable
with Ctrl-C and pasting the variable with Ctrl-V.

7.12.5 Creating the formula

The mathematical expression can be created in the formula window. The
four basic arithmetic operations, Boolean algebra and the setting of brackets
are available.

7.12.6 Checking the calculation

RiZone checks the formula for mathematical correctness. If the formula is
correct, it can be saved. The check is initiated by clicking the Validate
button.

7.12.7 Saving the formula

If the formula has been validated successfully, it can be saved. To start the
calculation, the project must be loaded to the server.

The formula is saved by clicking the Save button.

7.13  Calculation of a status variable

In addition to the normal variables that contain numeric values, status
variables can also be created. Although status variables can be created on
any infrastructure component (see 0), Statusint and state must be selected
as type and meaning, respectively.

The status variables can assume the values: 1, 2, 3, 4 or ok, warning,
alarm or undefined, and will be calculated in the following form:

if <number || variable> <operators> <number || variable> then
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<1l12113ll4llokllalarmllwarningllundefined> else
<1112113l14llokllalarmllwarningllundefined>

Example: if VAR_4711 > 30 then ok else alarm or
if VAR_4711 > 30 then 2 else 4

A space must be present before and after the operator.
The use of the and, or, not logical operators is also possible. These
operators must always be used with Boolean operators, such as:
if not(a>bandc!=b)then1 else 2
or
if (a < b) and (c == d) then 1 else 2
or
if(((@a+b)<c)or((x-y)==2))then 1else2

The calculation could have the following form in practical use:
if VAR_4711 > 30 and VAR_0815 < 40 then 1 else 2

Important!
The calculation of a status variable
must always contain the if .. then ..

else .. command structure!

7.14 Export/import project
The Project > Export project and Project > Import project functions can
be used to transfer projects to other servers.

Export project
An uploaded project can be exported. This also stores the
ClientRegistration.txt and NameRegistration.txt files in the project file.

Import project

This function can be used to import an exported project to the same or
another RiZone server (with the same version number). This deletes all
entries in the database (ClientRegistration and NameRegistration) and
replaces them with the registrations from the imported project.

Using the import/export function, projects can be ported between different
computers.

For this purpose, the two NameRegistration.txt and ClientRegistration.txt
files are also uploaded when a project is uploaded and the entries written to
the database when the RiZoneCore service is restarted. A check is also
made to ensure that the project, the settings of the Communication Module
and the DB match. These registrations make the project also operational on
servers on which the devices were not detected previously with the
discovery function.

This differs from the save/open project by the registration database entries
also being saved.
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Note!

After the import of a project, it is
possible that other projects of the
server that were saved with the "Save
project” function will no longer operate
correctly. If you want to reuse these
projects later, you must save them
previously with the "Export project"
function.

Note!

Self-created SNMP templates are not
transferred when a project is exported.
If a project that contains SNMP
templates for third-party devices is
"moved" to a different server, third-
party SNMP devices on the new server
will not be recognised.
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8 Views

The views can be used to create graphical representations of your complete
infrastructure components.

Views can be created for each component in the locations tree. A
differentiation between the lateral view and the plan view is made for the
representation of the views. Whereas the location, building and room
component types have a plan view, the enclosure suite and the enclosure
have a lateral view.

Customised graphics (e.g. the floor plan of a computing room) can be
created for plan views. The graphic can be manually overlaid with active
buttons that indicate the status of the components. For the lateral views, the
corresponding graphics of the enclosures and components are already
present in RiZone and only need to be assigned appropriately to the project.
The views are configured in admin mode.

Note!
Status variables must be assigned to a
d group so they can be evaluated

coloured in the view.

8.1 Creating a new view

The selection of the Views menu item creates the view for a component.
Only the view for one component can be edited concurrently.

The view opens in edit mode in the main view of the GUI.

A view is created by right-clicking the component icon. A context menu now
opens and the View function can be selected. Alternatively, moving the
mouse over the component displays five icons. The second icon from the left
E opens a new view.

The new view must first be scaled before it is created. This function can be
used to create scaled views on the component level because all RiZone
components exist as Sl units.

Scaling is made in mm and can be given a scale.
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8.2 Editing a view

A previously opened and stored view is opened for editing by calling the Edit
view function in the View menu.

The opened view has a pink frame that indicates the editing mode.

8.3 Loading a background picture

A right-click in the view window opens the dialog for loading a background
picture. Call Load background to open the Open file window from which a
.jpg format file can be selected. The file size of the picture may not exceed
1 MB.

The background picture will be created.

8.4 Assigning a component to a drawing

A component is assigned to a drawing by dragging in the drawing. The
mouse can be used to place the component anywhere in the view.

8.5 Saving the view
A view is saved by calling the Save view function in the Views menu.

8.6 Operating the views editor
The views editor provides the following functions:

.5 Zoom

[ Rotate

o Draw polygon

dexdt Add text

X Display variable in the view
) Undo

( Step forwards

8.6.1 Zoom

The zoom function can be performed by clicking the Magnifying glass icon
or by pressing the Ctrl key and using the mouse wheel.

Selecting the magnifying glass activates the zoom function. It is now
possible to zoom a rectangle from the view. A subsequent right-click restores
the original size.

A view can be zoomed by pressing the Ctrl key and the mouse wheel. The
view must be clicked to perform this function. The zoom function is then
available. Pressing the right mouse button restores the original size. When
the mouse wheel is turned forwards, zooming is made into the view; when
the mouse wheel is turned backwards, zooming is made from the view.

8.6.2 Rotate
A component is rotated in a view always at the centre of the selected

component. The Rotate icon is a sector of a circle with arrow U The
component is selected in the view and then the Rotate icon selected. Once
the rotate function has been selected, the component can be rotated.
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8.6.3 Polygons

The RiZone editor can be used to draw a polygon and then assign this
polygon to a RiZone infrastructure component. The polygon in the drawing
uses the colours green, yellow and red to indicate the three OK, warning and
alarm states of the component, respectively.

Note!
Status variables must be assigned to a
d group so they can be evaluated

coloured in the view.

The Polygon icon is used to activate the drawing of a polygon. A left-click
can now be used to add a corner of the polygon. A double-click closes the

polygon.

A drawn polygon can be edited in drawing mode. Individual corners can be
moved or corners added (arrow cursor and Ctir right-click on a line) or
deleted (arrow cursor and Ctrl right-click).

A polygon can be assigned to a component in the component tree. Please
proceed as follows:

1. Mark the component in the locations tree.

2. Keep the Alt key pressed.

3. Now drag & drop the marked component to the required polygon.
If the action completed successfully, the polygon colour changes to green.

8.6.4 Displaying free text in a view

The Text function can be used to display any free text items in a view.

The view must be open in edit mode. Click the Text icon in the editor toolbar.
Then click the view position where the text should be displayed (the
placement can be changed subsequently). A text input window opens. Enter
the required text and click OK to confirm.

Once the project has been loaded onto the server, the text will be displayed
in the view.

8.6.5 Displaying variables in a view

The V function can be used to display any variable values in a view.

The view must be open in edit mode. Click the V icon in the editor toolbar.
Then click the view position where the values of the variable should be
displayed (the placement can be changed subsequently). A variable
selection window now opens. Move a sensor or component with drag & drop
into the variable field. You now have the selection of all values of the sensor
or the component. Select the required values and click OK to confirm. Once
the project has been loaded onto the server, the variable value and the unit
will be displayed in the view.

8.6.6 Undo
The Undo function can be used to undo the creation steps.

8.6.7 Restore
The Restore function undoes the undo function.
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8.6.8 Multiple selection

A multiple selection of components is possible by drawing a frame around
the components to be selected. The selected components are coloured.

8.6.9 "Go to" and "Open website" functions

View mode: If a view is open, a right-click on the individual components (e.g.
PSM busbar) calls a context menu. Depending on the component and the
configuring, none or one of the Go to or Open website options appears
here.

Go to

The view of the clicked infrastructure components opens. This is possible
only when the view was created previously in admin mode.

Example: In the multiple-enclosure view, a right-click is made on a specific
enclosure and Go to selected. The enclosure view (provided created) of the
selected enclosure now opens.

Open website

A right-click on a sensor connected to a Processing Unit Il or an LCP opens
the context menu with the Open website option. The selection of the Open
website item opens in the standard browser the website of the Processing
Unit Il that belongs to the sensor.

8.6.10 View list
The view list of a component can be called from its context menu (right
mouse key).

In admin mode, existing views can be edited or new views created in the
view list.

In view mode, a selection from the existing views can be made. A double-
click on the view opens it.
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The chart function can be used to display measured values graphically in
RiZone. It is possible here to display several values in a diagram.

Charts must be grouped in admin mode. When the project is started, the
created charts can be called and then show the current and historic acquired
values.

The chart list shows all charts assigned to the infrastructure component. The
context menu (right-click), new charts can be created or existing charts
renamed or deleted.

9.1 Creating charts
Charts are linked to a component (sensor, PU, LCP, etc.) or an infrastructure
component (location, building, room, enclosure suite, enclosure) during their
creation. For a started project, these charts can then be called using the

appropriate (infrastructure) components.
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Fig. 20 Creating a chart

To create a new chart, right-click the component with which the chart is
linked and select Charts or Chart list. The chart list shows all charts
assigned to the infrastructure component. The required chart can be
selected with a double-click from this list.

The chart configuration now opens in the View window.
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[2112] LCP 22 :Charts % X ]

Selektion

Name

Beschreibung

Diagrammauswahl

Konfiguration Chart: LCP 2.2

| LcP Standard Mai ~ |

|AirTemperature vl Mame Air Temperature

(2112)

L) (=

LCP Standard Main
Default Chart LCP Standarc

Diagrammiyp | Linie

. ] 2

Farbe Beschreibuna Achsenbeschrftur  Variable Min-¥ Max-¥ Einheit AchsenlDFormat Faktor |Z| | | 3
[ Actual Temperature Temperature | Temperature v| ] 100 c - L—v| gnepx
B et High Temperature |Temperaturﬁ v| 0 100 Coo- |D—v| QoI
Bl cetlow Temperature |Tempera1urﬁ v| 0 100 cC - |D v| 0 R0 1
I:I Set Warning Temperature |Temperature v| 0 100 cC - |D v| o He N1
¥ | Chart Vorschau
Fig. 21 Chart configuration
Legend

RiZone

1 Add/remove a new chart
2 Add/remove a diagram within a chart
3 Add/remove a variable to/from a diagram

Input possibilities in the chart configuration

Name Name of the chart

Description Description of the chart

Name Diagram name

Diagram type Representation of the values in the diagram as
line, pie or bar chart (Gantt)

Colour Measuring curve colour. Clicking the colour opens
a colour selection palette that can be used to
specify the colour for this measured value.

Description Description of the measured value

AXxis caption Title of the Y-axis for this measured value

Variable The measured value to be displayed is selected
here.

Drag & drop a component from the project tree to
the Variable field. The drop-down menu can then
be used to select all available measured values of
the selected component. This value will then be
displayed later in the diagram.

Min-Y Minimum value of the Y-axis. It should be adapted
to the expected minimum value of the selected
measured value.
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Max-Y

Maximum value of the Y-axis. It should be adapted
to the expected maximum value of the selected
measured value. If Min and Max = 0 are specified,
an automatic scaling will be performed.

Unit

Unit of the acquired measured value

AxisID

Selection of the associated axis. If several units
are used, each unit has its own axis.

Format

1st field: Minimum number of digits before the
decimal point (permits the alignment of the
measured values under each other in the diagram
legend)

2nd field: Digits after the decimal point

Factor

Scaling factor for the measurement curve and
legend. Can be used, for example, to output
energy values in kW rather than watts.

Chart preview

Displays a preview of the configured chart.

The + and - buttons can be used to add or remove values to/from the chart.
Click + to add a new configuration row. These values can originate from
different components. This allows the very flexible creation of individual

charts.

A click on — removes the marked measured value row from the chart

configuration.

The drop-down main menu can be used to discard any changes that have
been made. To do this, select Charts > Reset chart. RiZone contains
standard charts for some components (LCPs). They can be restored at any
time with Charts > Load standard charts.
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[238]LCP 1.3 :Charts % X ]

Konfiguration Chart: LCP 1.3 (239)

Selektion LCP Standard Main v | D

Name LCP Standard Main |

Beschreibung | Default Chart LCP Standard |

Diagrammauswahl

tir Temperature | Name |NrTemDerature | Diagrammiyp D

Farbe  Beschreibung  Achsenbeschriftung  Variable MinY MaxY Eimheit AchseniD Format Faktor (-]
] |Actua| Temperaturs ||Temperature ||Temperaturef'v| | 0 ||100 °c v| |D v||0 ||0 ||1 |
-|SetHigh ||Temperature ||Tempemtures v| | 0 ||100 °c v| |D v||D ||& ||1 |
-|SEtLDw ||Temperature | | Temperaturet v||D ||1DD ac v||D v||0 ||u- ||1 |
.|5et Warming ||Temperature ||Tempemturef v| | 0 ||10c- °c v| o v|[o][e ||1 |

~ | Chart Vorschau

Fig. 22 Chart configuration example

Fig. 22 shows an example configuration for an LCP chart that shows the
LCP temperature (green), the high temperature warning threshold of the
LCP (red), the low temperature warning threshold of the LCP (blue) and the
warning temperature warning threshold of the LCP (orange).
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9.2 Displaying a chart
Once the chart has been configured, the chart together with the complete

project can be loaded to the server (Project > Upload to server or .fﬁu ).
The chart can also be fetched when the project is performed (Project >

Start project or ..'-i?_ .
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Fig. 23 Fetching a chart

To do this, right-click in the project tree the (infrastructure) components to
which the chart was linked for the configuration and select Charts or Chart
list. If Chart list was clicked, the chart still to be edited must now be
selected.

The chart opens in the View window and the values supplied by the
components to RiZone are shown.
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Fig. 24 Chart representation for the started project

The elements in the uppermost line of the chart window can be used to set
the representation interval of the chart.

1 | Interval The time interval of the chart display can
be selected here (15 minutes, hourly,
daily, etc.).

2 Updates and sets the cursor to the
current value in the chart.
3 | Time The date and the time when the chart

display should begin can be specified
directly here.

4 | Chart selection If several charts were created for the
component, it is possible to switch
between the individual charts here.
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10 Workflows

10.1 Operation of the workflows in RiZone

The workflows in RiZone are used for the automatic processing of
conditional actions. The actions involve the setting of values using SNMP,
the sending of e-mails and the parameterised call of external programs. The
values of the monitored devices collected by RiZone or the variables
calculated by RiZone can be used for the conditions that determine the
execution of an action. Once a workflow together with a project is uploaded
to the server, the workflow becomes active and will be executed by the
server.

10.2 Creating a new workflow

A workflow is always assigned to an infrastructure component (room,
enclosure suite, etc.). Each workflow, however, always has access to all
sensor values of the project and not just to the values assigned to "its"
infrastructure component.

To create a new workflow, right-click the infrastructure component and select
Workflow list in the context menu.

The overview window for all workflows of the component (workflow list) now
opens. A right-click on New in the workflow list creates a new workflow.
Enter a name for the workflow and click OK to confirm. The new workflow
will now be shown in the list and can be edited.

10.3 Deleting a workflow

To delete an existing workflow, right-click the infrastructure component and
select Workflow list in the context menu.

The overview window for all workflows of the component and the logically
subordinate components now opens.

A right-click on the workflow to be deleted opens the associated context
menu. Select Delete to delete the workflow.

Click Yes to confirm the delete action.

The workflow will now be deleted. To also delete the workflow on the server,
the updated project must first be uploaded to the server (see Upload
project).

10.4 Editing a workflow

To edit a workflow, right-click the infrastructure component and select
Workflow list in the context menu.

Right-click to select the workflow to be edited. The associated context menu
opens. Select Open.

The graphical workflow editor now opens.

The pink frame of the workflow editor window indicates the edit mode. The
editing is completed with the Workflow > Save workflow drop-down menu
(the pink frame vanishes). To return to the edit mode for an open workflow,
select Workflow > Edit workflow.

The workflow can now be formed using workflow modules (see Workflow
modules section). To create a workflow, click the required modules in the
module bar which then appear immediately on the workflow work surface.
After the first click on the icon, it appears on the work surface, brought to the
correct position and released with a left-click.

A double-click on an icon opens the associated properties menu. The
properties of the module can then be configured (for details, refer to the
Workflow modules section).
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10.5  Structure of a workflow

A workflow consists of various modules (refer to Workflow modules section)
connected with each other using arrows (directed edges). The arrow
direction also specifies the flow direction through the workflow.

During the creation, ensure that:

1. Just one start symbol exists.

2. Atleast one end symbol exists.

3. All modules have just one successor (= outgoing arrow). The Event
Gateway and Data Gateway are exceptions. These elements can
have several successors.

4. All symbols are connected with each other using arrows.

5. At least one action must be defined.

A workflow will be validated for correct syntax before it is saved. The
workflow must be corrected if the validation fails.

The error description for the errors on the workflow will be output in the
message list.

Otherwise the workflow will only be saved and not switched active when
uploaded to the server.

Note!
During the RiZone operation, it is not
possible to determine whether a

workflow is active.

Check carefully the validation of the
workflow.

10.6 Workflow modules
This section describes the individual workflow modules and their
configuration capabilities.

10.6.1 Start event

)

Fig. 26 Start event

The Start event indicates the starting point of each workflow. It must be
present just once in each workflow. The properties menu contains only the
name and the unique symbol ID (UID).

10.6.2 Stop event

)

Fig. 27 Stop event

The Stop event terminates a workflow. At least one Stop event must exist
for each workflow. Several Stop events are possible in a workflow.

The properties menu contains only the name and the unique symbol ID
(UID).
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10.6.3 Condition event

9

Fig. 28 Condition event

The Condition event stops the workflow at this point until the set condition
(e.g. an alarm of a specific sensor) occurs.

RiZone - Workflow properties: FlowElement

= FlowElement

Mame | |

up | |

Exprassion Nature \ariablz v
Variable Valus (412) »
| = Equel

20

Apply ” Resst

Fig. 29 Condition event properties

A double-click on the symbol opens the properties window of the Condition

event. To configure the condition, proceed as follows:

1. Select the Operator in the lower window. The Equal operator is
selected in the figure. Possible operators are: Equal, Unequal,
Above, Below, AboveOrEqual, BelowOrEqual, And, Or, NAND,
NOR.

Now select the first operand.

3. The Nature menu can be used here to select whether a constant or
variable is involved. If you select a variable, a sensor that supplies
the required sensor value must then be selected. To do this, left-
click the required component from the locations or devices view and
move with drag & drop to the free menu field with the designation
Variable.

N
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4. You can then select from the selection menu a variable from the list
of all variables supplied by the component.

5. If you want to enter a constant, select for Nature the Constant
option and enter the required value for Value.

6. Select this for the second operand and repeat steps 3 to 5 as for the
first operand.

Note!
Nested operations are possible when
"and" or "or" is selected as operator.

Click Apply to accept the changes or Reset to reset all settings. The window
can be closed by clicking the "Close window" icon at the top right.

10.6.4 Timer event

@

Fig. 30 Timer event

The Timer event stops the workflow at this point until the set time has
expired.

A double-click on the icon opens the properties window of the Timer event.
The time unit (seconds, minutes, hours, days) and the time value can be set
here.

Example: A delay of 15 seconds should be set
Unit = seconds
Time =15

10.6.5 Send Email

Fig. 31 Send Email event

The Send Email event can be used within a workflow to send an email. The
email will be sent when the workflow reaches the Send Email event.
A double-click on the icon opens the properties window of the Send Email
event.
The following parameters must be configured here:

e Receiver: Target address

e Subject: Subject line

e Text: Email text

e Sender: Sender address

e SMTP Server: IP address of the SMTP server

e SMTP User: If the authentication is successful, the user name must

be entered here

e SMTP Password: If the authentication is required, the password
must be entered here
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10.6.6 Execute Program

Fig. 32 Execute Program event

The Execute Program event can be used within a workflow to start an

external program on the server. The program will be started when the

workflow reaches the Execute Program event.

A double-click on the icon opens the properties window of the Execute
Program event.

The following parameters can be configured here:

e Program: The program name, incl. path. Important: The program
must be located on the RiZone server rather than on the client on
which the GUI runs.

¢ Arguments: Call parameters for the program to be started. The
values and the syntax depend on the program to be started.

Note!
The program will be executed on the
RiZone server under the RizoneService

user. This means the graphical user
interface for the executed program is
not visible.

10.6.7 Set Value

Fig. 33 Set Value event

The Set Value event can be used to set a value within a workflow using
SNMP. This requires that the actor has already been integrated in the
RiZone project using the Discovery function. The value will be set when the
workflow reaches the Set Value event.

A double-click on the icon opens the properties window of the Set Value
event.
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Fig. 34 Properties of the Set Value event

To configure the setting of a value, proceed as follows:

1.

2.

3.

Left-click the required component from the locations or devices view
and move with drag & drop to the free menu field with the
designation Variable.

Note!
If the Variable field remains empty after
a device has been added, this device

does not have any variables that can
be set.

You can then select from the selection menu a settable variable from
the list of all variables supplied by the component.

Now enter for Value the value to be set on the actor or select one of
the states that may be specified.

Click Apply to accept the changes or Reset to reset all settings. Click OK to
close the window. Cancel terminates the configuration of the workflow.
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10.6.8 Event Gateway

&

Fig. 35 Event Gateway

The Event Gateway is a branch on two or more Condition events.
Important note: The direct successors of an Event Gateway can be only
Condition events or Timer events (refer to the Event Gateway example
figure).

Fig. 36 Event Gateway example

If, during the processing, the workflow reaches the Event Gateway, the
workflow will continue at that Condition event whose condition is satisfied
(true) first.

Note!
This condition is executed just once.

The condition will be executed again
only when it reoccurs.

Note!
If no condition is satisfied, a wait will
be made at the Event Gateway.

The wait at the Event Gateway
continues until one of the conditions is
satisfied.
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10.6.9 Data Gateway

Fig. 37 Data Gateway

The Data Gateway is a branch on two or more events.

The direct successors of a Data Gateway can be all modules except for the
Start symbol.

The conditions that determine which path the workflow follows are linked at
the outgoing edges for the Data Gateway.

To specify a condition, the properties window of the edge must first be
opened with a double-click on the edge.

RiZone - Workflow Eigenschaften: Link

= Link
Typ Expression W
Mature Cperatar W
Cperator AboveCrEqual W
= ==
]
]
Ausdruck
[ Ok ] [ Abbrechen ] [ Ubernehmen ] [ Zuriicksetzen

Fig. 38 Properties of an outgoing Data Gateway edge

The condition can now be specified as follows:

1. Select the Operator in the lower window. The AboveOrEqual
operator is selected in figure 38. Possible operators are: Equal,
Unequal, Above, Below, AboveOrEqual, BelowOrEqual, And,
Or, NAND, NOR.

2. Now select the first operator.

3. The Nature menu can be used here to select whether a constant or
variable is involved. If you select a variable, a component that
supplies the required sensor value must then be selected. To do
this, left-click the required component from the locations or devices
view and move with drag & drop to the free menu field with the
designation Variable.

4. You can then select from the selection menu a value from the list of
all values supplied by the sensor.
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5. If you want to enter a constant, select for Nature the Constant
option and enter the required value for Value or select one of the
states that may have been specified.

6. Select this for the second operator and repeat steps 3 to 5 as for the
first operator.

7. Click Apply to accept the settings.

The condition for this edge is now configured.

Fig. 39 Default Gateway example

Important!
One edge must be defined as default

edge. To do this, the value for Type in
the properties must be changed to
default.

If during processing the workflow
reaches the Data Gateway and no
condition of any of the outgoing edges
is satisfied (=true), the workflow will be
continued at the default edge.

NS
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11 Maintenance mode

The maintenance mode indicates that the configuration of a device has
changed. In this state, the device data can no longer be evaluated in
RiZone. The maintenance mode can either be set manually with the Service
variable or activated automatically by the system when certain events occur
(see 11.1).

The maintenance mode is indicated by a spanner in front of the devices
icon.

3 E Basic

Digitaler Ausgang
{ [ Temperatur Sensor

All variables of the affected device change their state:

Quality = "Bad"

Quality Detail = "COMPONENT_MAINTENANCE_MODE"

The maintenance mode causes the variable calculation of the Calculation
Engine to be delivered automatically with the Quality Bad. No new events
are initiated by the Quality Bad variable in the Workflow Engine.

There are several possibilities why a device has changed to maintenance
mode. There are two ways of leaving the maintenance mode:
e The device changes its configuration back to the original state. In
this case, the maintenance mode will be deactivated automatically.
e The device will be rediscovered in the configuration mode and with
pressed Alt key moved to the affected device in the project tree. The
current settings are now accepted as original.

11.1 Reasons for a maintenance mode

11.1.1  Change of the temperature unit

For Rittal CMC devices, the temperature unit can be changed between °C
and °F. This also changes the values transported via the SNMP interface.
This situation means the calculated values and limit value tests in a workflow
are incorrect and the maintenance mode will be activated. If the device
changes its temperature unit back to the configured state, the maintenance
mode will be revoked automatically (if the change is made from the website,
this can take as long as five minutes). Incorrect calculations and workflows
cannot be excluded during this time.

The maintenance mode is activated only for those devices that supply a
temperature value. You can recognise this by them having a "Temperature
Unit" entry in the properties window. This shows the state present during the
Discovery.
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20553
Temperatur Sensor
7320.500
Temperature Sensor

CELSIUS

Rittal_Sensor_Temperature
1.1.0
supported devices 7320.500

The following devices have this field:
LCP

LCP Extend

LCP Inline

LCP Inline EC

LCP Plus

LCP Plus EC

LCP Smart

LCP T3+

LCP T3+ AC

Temperature sensor

Temperature sensor WL

The Climate Unit does not have this field because the temperature sensor
exists as an independent device.

11.1.2 Change of the hardware configuration
The possible changes are listed in the properties of the LCPs.

1D 7850

MName Mame of the Unit
Model Mumber 3301.480
Component Type  LCP Plus

IP Address 10.201.49.167

Temperature Unit  CELSIUS

Water sensors Activ

Flowmeter Activ
Control valve Activ
Condensation pump Activ
Serial Numbser 1385
Location Location of the Unit

These properties are assigned to the device during the Discovery. If these
no longer match those of the device, a switch is made to maintenance mode.
The maintenance mode will be exited when the old state is restored. If the
device with the changes is to be accepted, it must be deleted from the
project and a new discovery performed. Alternatively, it can be moved with
pressed Alt key to the existing component and so updated.

The following devices have these fields:

LCP Inline / Water sensor / Flowmeter / Control valve
LCP Inline EC / Water sensor / Flowmeter / Control valve
LCP Plus / Water sensor / Flowmeter / Control valve
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LCP Plus EC / Water sensor / Flowmeter / Control valve

LCP Smart  / Water sensor / Flowmeter / Control valve / Condensation
pump

LCP / Fan module 1 / Fan module 2 / Fan module 3 / Water
module

11.1.3 Change of the configuration

If a device (PU, LCP, etc.) enters the "Configuration Changed" mode, this
device will be set into the maintenance mode.

The following procedure must be adopted to return the device to the active
mode:

1. Acknowledge the "Configuration changed" status on the Processing
Unit.

2. The component must be updated in the project. To do this, perform the
discovery of the component again and with pressed Alt key use drag &
drop to move the newly discovered device to the component already
present in the project. This updates the data for this component in the
project.

3. Components that no longer exist must be deleted from the project.

4. Finally, upload the updated project to the server.

11.1.4 Service variable

Devices and infrastructure components that possess the Service variable can
be placed into the maintenance mode by setting the variable to the
Maintenance value. To exit the maintenance mode again, either the Service
variable can be set to active or the project uploaded to the server again.

Important!
If an infrastructure component (e.g.

rack suite) or a device with
subordinate components (e.g. PU with
multiple sensors) is placed into the
maintenance mode, all subordinate
components/sensors will also be
automatically placed into the
maintenance mode.

To return all components to the
"active" mode, the Service variable of
all subcomponents/sensors must be
individually set to "active" again.

As an alternative, the complete project
can be uploaded to the server again.
This also sets the components back to
"active".
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12 Message list

RiZone has a message list that contains all messages of the RiZone server.
The messages have various categories, owners and states. Each message
has a unique timestamp and owner. The message description explains the
message. Moving the mouse over the message displays the description of
the message as tooltip.

The message list differentiates between current messages and finalised
messages. Closed messages are current messages whose status has
been set manually to Terminate. To set the Terminate status, the message
must be opened with a double-click. The status then can be changed from
the drop-down field. The time interval for which messages are displayed can
be restricted. The restrictions are:

All, 1 hour, 1 day, 1 week.

All messages for specific categories can be filtered. The categories are:
Errors, Warnings, Information and OK.

The filtering applies to the displayed messages rather than all messages in
the database.

The arrow keys can be used to navigate through the message list. A right-
click opens the context menu. A double-click opens the properties window
of the message.

The individual columns can be sorted in ascending and descending
sequence. The sorting applies to the displayed messages rather than all
messages in the database.

121 Process
Process assigns the message. The following processes are differentiated:

12.1.1  Monitoring

The messages grouped in the Monitoring process apply to the active area of
RiZone.

12.1.2 System
The messages grouped in the System process are system messages.

12.1.3 Workflow

The messages of the Workflow process are those messages issued while
uploading a project when one or more workflows were created in a project.

12.1.4 Calculation

The messages of the Calculation process are those messages issued while
uploading a project when one or more calculations were created in a project.

12.1.5 Discovery

The messages of the Discovery process provide information about the
devices found during the discovery process. If RiZone does not support a
firmware, an error message will be issued during the Discovery process.

12.2 Owner
The owner of a message is the component ID for RiZone. This can be a
device, a workflow or a calculation.

12,3  Status
The status of a message indicates the processing status of a message.
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12.3.1 None

The None status specifies that the message has not yet been accepted by
any user in RiZone. The message is not yet processed.

12.3.2 Commit

The Commit status specifies that the message has been accepted by a user
in RiZone. The message is not yet processed.

12.3.3 Confirm
The Confirm status indicates that the message from a user in
RiZone has been confirmed. The message is not yet processed.

12.3.4 Work On

The Work On status specifies that the message has been accepted by a
user in RiZone. The message is being processed.

12.3.5 Terminate

The Terminate status specifies that the message has been accepted by a
user in RiZone. The message is completed.

Messages with the Terminate status can be viewed only from the Finalised
messages tab.

124 Properties

A double-click on a message opens the properties window. The detailed
message is displayed in the properties window. It is possible to change the
status and add a comment to the message. The user who accepted the
message is logged.

A history of the messages is saved.
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13 Report

RiZone provides the capability to generate a report for the variables
associated with a node. This report can be executed cyclically and
downloaded from the server to the client PC. The access control for a report
is controlled in the user administration.

13.1 Creating a report

A report can be created for any component of the RiZone project. The
Report function in admin mode opens the configuration window in the GUI.
The New function creates a new report.

[ [812] Schranks : Workflow Liste TJEH] Schrank3 @ Berichte | [312] Schrank3 : NeuerBericht |

[Gruppieran  Variablz suchen:

D Mama ID Name
101 Type

103 Text .: N

105 Status .

Name | NeuerBericht Baschreibung | Berichts Beschreibung
Iyklus |Nie v

Fig. 39b Creating a report

13.1.1 Selecting variables

The variables are selected with a mouse click in the window. Ctrl and
mouse click are used to select more than one item. Shift and click are
used to select a group of variables. The marked variables have a blue
background. A click on the >> double-arrow transfers the variables to the
selection window. The selection of the variable and the click on the <<
double-arrow deselects the variable.
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13.1.2 Name/description

The name of a report is a mandatory field and preassigned. Only digits,
alphabetic characters and the underscore can be used for a name. Accented
characters are not supported. The name of a report may not begin with a
digit. The maximum length of the name is 50 characters.

The report description is optional. The maximum length is 256 characters.

13.1.3 Cycle

The regular execution of the report is configured in the cycle selection
window. Never specifies that no report will be created.

13.1.4 Saving a report

A report is saved by selecting the Reports tab in the menu and then clicking
Save. The report will be saved under the selected node. The changes take
effect on the RiZone server only when the project has once again been
uploaded to the server.

13.2 Deleting a report

A report can have been created at any node of the RiZone project. The
Report function in admin mode opens the configuration window in the GUI.
A list of the reports present for the node is displayed. A click on Delete
deletes the associated report. Respond with Shift and click to the prompt.
Alternatively, you can mark the report with the left mouse button and delete
with the Del key.

13.3 Downloading a report

A report can be downloaded in the view mode of the GUI. The logged-in
user must have the appropriate authorisations. The report has CSV format.
The reports are saved in the ~\My Documents\RiZone\Reports directory.
The report is downloaded by selecting the appropriate report and then
selecting the Synchronise function. The Reports > Synchronise all option
in the drop-down menu downloads all versions of the report.
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14 User administration

The RiZone user administration is based on the user administration of the
RiZone Appliance operating system. The membership of the RiZone
Appliance in the directory setrvice is used to integrate the user administration
in a directory service.

14.1 Creating a user with the GUI

A new RiZone user is created from the Administration > User
administration > Users > Create user menu. The user is created as local
user on the RiZone Appliance. The user name must consist of at least five
characters and the password requires a minimum length of seven
characters, including one special character. The assignment of the e-mail
address must be unique: An e-mail address can only be entered for one
user. All fields are mandatory for creating a user. The activation of the
Enable user? checkbox activates the user.

Note!
A user must be activated in order to
log in to the RiZone server.

I\

Activate the user during the creation.

14.2 Changing a user account

A user account is changed using the Administration > User administration
> Users menu. Select the user with a double-click.

The e-mail address and the comment for the user can be changed in the
Change details menu item.

The Change password menu item is used to change the password.

The Administer roles menu is used to assign the user to one or several
roles.

The Delete user account menu item is used to delete the selected user.
The Deactivate user account function is used to deactivate the user. The
user can then no longer log in to RiZone. All user settings, however, are
retained.

The Activate user account function is used to activate the user.
Administer other user accounts returns to the user selection.

14.3 Creating a role with the GUI

A new RiZone role is created from the Administration > User
administration > Roles > Create new role menu. The role is created as
local group on the RiZone Appliance. The group name must begin with
RiZone.

Note!
Role names cannot be changed later!
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14.4  Assigning a user to a role

The Change user account > Administer roles menu is used to assign the
user to one or more roles.

This is also possible by selecting the appropriate role and assigning the user
to the role in the Roles menu.

14.5 Removing a user from a role

The Change user account > Administer roles menu is used to remove the
user from a role.

This is also possible by selecting the appropriate role in the Roles menu and
removing the user from the role.

14.6 Deleting a user with the GUI
The Delete user account menu item is used to delete the selected user.

14.7 Deleting a role with the GUI
To delete a role, proceed as follows:
e Select the Role tab
e Double-click the role to be deleted
o Click Delete role
e Confirm the prompt
The role will now be deleted.

14.8  Configuring RiZone in a directory service

RiZone is integrated in a directory service by the membership of groups of
the directory service in the local groups of the RiZone server that were
created as role with the RiZone GUI.
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15 Assigning rights for RiZone components

Rights are assigned in a project at the component level in the project tree.
The component rights are assigned to a RiZone role. This role is assigned to
a user group of the operating system. Rights can be assigned in the
locations tree and the devices tree.

15.1 The rights concept for RiZone

RiZone has seven different authorisations. These authorisations can be
used for just one component or can be inherited. The inheritance permits all
subordinate components of the selected reference tree to be given the same
rights.

15.2 RiZone rights

156.21 Read

The read right permits read access to the component. No changes can be
made to the component.

15.2.2 Setting
The setting right permits the change of threshold values.

15.2.3 Configuration

The configuration right permits the change of a component. This permits
the change of the component name or the change of the SNMP
configuration. Specific LCP settings are also assigned to the "Configuration”
group (some parameters from LCP Standard and Extend).

15.2.4 Execute

The execute right permits the switching of the outputs of a device that has a
switching function.

15.2.5 Charts

The charts right permits the display of a chart. The chart must be created by
an administrator.

15.2.6 Workflows

The workflows right permits the display of a workflow. The workflow must
be created by an administrator.

15.2.7 Reports

The reports right permits the download of a report. The report must be
created by an administrator.

15.3 Changing an authorisation in the object tree

The rights are assigned for a component in the properties window. The
properties window is opened with a right-click on the component icon and
the selection of properties. The properties window opens in the GUI main
window. The selection of the Rights tab opens the rights administration.
The Reference tree drop-down menu is used to select in which project tree
the rights assignment is made. The Subordinate components ... checkbox
permits the inheritance of rights below the component.
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It is possible to assign a role to each individual right. Multiple selection is
possible.
The changes take effect only after the upload of the project.

16 Searching for variables
RiZone provides the capability to search for variables. It must be selected

under which component the variable should be searched. After the selection
of the component in the location or device tree, all available variables will be
displayed in the variable view. The search for a variable can now be made in

the Variable window. The use of * wildcards is possible.

17 Relocating a tab as a single window

When several monitors are used, it can be desirable to relocate the
individual tabs of the RiZone GUI to another monitor. This is done with a
click on the Relocate tab icon.

This function is possible only in view mode.

=R 1111 -]

erg : Ansichten 4—ﬂ/

Flan Visw -

If the relocated window is closed, it will once again be integrated as tab in
the GUL.

71



18 Setting values

18 Setting values

18.1 Setting the values of a component from the user
interface
The RiZone user interface serves not only for querying of data using SNMP,
values such as thresholds for temperature sensors can also be set. This
function is available only in view mode and the logged-in user requires the
necessary authorisations.
To set or change a value, proceed as follows:
¢ Right-click to select the component/sensor in the project tree and
select Variables in the context menu. The variable view of the
component now opens in the View window.

LJ RiZone [User=RiZoneAdmin, Server=rizone2,
Projekt  Bearbeiten Renel
el gl e L L

Standorte | Gerate |

= [ P19.11.2009
= E’ Rittal Herborn
= IDJ Showroom
= '-l'l]j Serverl.l
H Mtf\l‘rv\n‘ﬂx -
5 ] server IR -
sn

@ Offne Webssite
Lezkage Sensor

[ﬁ Temperatura Rack 02
m PSM 1
= lm Server3
_-m Access SensorY
m LCP 2.2
m LCP 2.3
F|]]l LCP 1.3

e Now click the Set button after the variable value in the View window
that you want to change.

.| RiZone [User=RiZoneAdmin, Server=rizone2, Modus=Yiew]

72

s -
Standorte | Gerite | [2865] Metered?SM : Variablen 1 X |
= [ P 19.11.2008 i) Vit sichens
= [ Rital Herbomn A
= i showroom Name e :
= [l servert.: Name MeteredPSM [setzan
i Meteradesi Serial 1301
= [ server 2 Status 0Ok oy
Skl Slnaor ValtageC1P1_State ok (0]
| Eonell| (e =
[ Temperaturs Rack 02 = = bl
s 1 VoltageC1P1_Settigh Setar
= [ servers VoltageC1P1_Setlow 1005 V | Setzen
|8 hccess Sensery VoltageC1P2_State ok o}
flic22 ValtageC1P2_Value 2284 v
m: e VoltageC1P2_Name  Voltage Status 1:2 @
ﬂ[! P ;.3 VaoltageC1P2_SetHigh 2400 V @

You can change the value either by the direct input of the value or
using the slider in the Set value window that now opens. The slider

specifies the permitted value range to be selected.
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RiZone

Wert setzen X]
VoltageC1P1SetHigh
Meuear Weri:
241 k)
L
110 260
[ Setzan ]
[ abbrechen ]

If only certain values are permitted, a drop-down menu lists all

possible inputs here.

After changing the value, click the Set button to transfer the value to

the component.

Once the value has been written successfully, it will be displayed

immediately in the View window.
ValtageC1P1_Name Voltage Status 1:1
VoltageC1P1_SetHigh 2410 WV

VoltageC1P1_Setlow 100,5 V

Note!
To set one or more values, the IP of the RiZone

server must be entered as trap receiver in the
component (e.g. CMC Processing Unit Il). If this
is not the case, the component does not accept
any values from the RiZone server.

Note!
If the value cannot be set, an error message will

indicate this situation. In this case, the value
must be reset and Set clicked to reinitiate the
action.
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18.2 Setting several values simultaneously
In addition to the setting of individual values, the RiZone user interface can
also be used to change several values simultaneously.
¢ Right-click to select the component/sensor in the project tree and
select Variables in the context menu. The variable view of the
component now opens in the View window.

LJ RiZone [User=RiZoneidmin, Server=rizone2,

Projekt  Bearbeiten
it gl e L Lk

Standorte [Geréte ]
= [ P19.11.2009
= m Rittal Herborn
= w Showroom

= 'l]] Serverl.l
P o ¥ I

= Im i @ Offne Webssit=

sn
Lezkage Sensor
Temperatura Rack 02
m PSM 1
= llm Server3
_-m Access SensorY
m LCP 2.2
m LCP 2.3
FI]II LCP 1.3

e Now select in the View window all values that are to be changed
simultaneously. To do this, click successively all variables to be
changed while keeping the Ctrl key pressed. It is also possible to
mark an area by pressing the Shift key.

VoltageC1P1_SetHigh 41,0 v |Getzen|
VoltageC1PL_ Setl ow 1005 V
VoltageC1P2_State ok i
VoltageC1P2_value 2281 v

VoltageC1P2_Name  Voltage Status 1:2
VoltageC1P2_setHigh 2400
ValtageC1P3_State ok 1
VoltageC1P3_Value 27,5 v

VoltageC1P3 Name  Voltage Status 1:3
VoltageC1P3_SetHigh 2420 v
VoltageC1P3 Setl ow 1005 Vv
CurrentC1P1_State ok it

¢ Now click the Set button for one of the selected variables.

e The Set value dialog for several values opens.

e To set values simultaneously, the selection box in front of each
selected variable must be set.
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YWert setzen

VoltageCiP15et ow

MName
VoltageC1P1_Setlow
VoltageC1P2_Setlow
VaoltageC1P3_Setlow

Wert
100,5
188,0
100,5

Einheit

v
v
v

Status

ES]

50

Meauer Wert:

00| v

‘Wert setzen

240

Now enter the value to be used for all selected variables as New

value and click Set value to confirm.

Werk setzen @
VoltageC1P15et ow
Name Wert Finheit  Status Neuer Wert:
[] voltageC1P1_Setlow 1005 v
[] VoltageC1P2_Setlow 1880 v v
[] VoltageC1P3_Setlow 100,5 v j
o0 240
Abbrechen
Caution!

>

Select the same variable types, such as

VoltageCxPx_SetLow

Only the same variable types can be set with a
multiple selection.
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e Once the values have been written successfully, they will be
displayed immediately in the View window.

=~ rre ———
VoltageC1P1_Setl ow v

VoltageC1P2_State ok i
VoltageC1P2_valus 2280 Vv

VoltageC1P2_Name  Voltage Status 1:2
VoltageC1F2_SetHigh 2400
VoltageC1P2_Set ow v
VoltageC1P3_State 0k

VoltageC1P3_Value 2284 V

VoltageC1P3_Name Voltage Status 1:3 n
VoltageC1P3_SetHigh 2420 v Setee

VoltageC1P3_ Set ow
CurrertC1B1 State Nk i

/ Note!
If the trap receiver is not configured on the

RiZone server for the PU, the changes will only
be transferred to the RiZone server after five
minutes at the latest. If the change should be
made faster, the PU must be rediscovered and
replaced in the project tree.
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19 Configuration of the SNMP devices

19 Configuration of the SNMP devices

The SNMP devices are configured during the configuration and in the
running project. During the configuration, the variables of the discovered
devices are configured.

The SNMP communication will be activated when the project is started. If the
project has been started, the individual devices can be configured.

19.1 Configuration of variables

In addition to the SNMP-polled variables, variables can also be created
manually. Their value can be calculated using arithmetic operations for
polled or other manually-created variables. This makes it possible, for
example, to create a variable that calculates the total power consumption of
a rack when the individual values are fetched in RiZone with SNMP polling.
For the configuration of a variable, the GUI must be in admin mode and a
device in the project tree selected. A right-click on the variable opens the
context menu. The Variables option will be selected. The variables window
of the selected component opens in the main window (View window) of the
RiZone GUI. If required, click Down arrow to open the variables list.

i1

Projekt  Bearbeiten Grafik Regeln Charis  Adminisirstion  Hiife
Standorte Gerste | [1552] 201.047.014.003.001 :Variablen x |
= [l Loh-Services Variable(n) &Idﬂ'fll [~ Gruppieren  Variable suchen: |
= [Hf201.047.014.003.001
= Ejiout o] Neme | T | Wert | Einher| tneervan péad
)i ot 8 20LOATO003.001 ]
Humidity Sensor 001 Name String 201.047.014.003.001
Smoke Sensor 001 String de he hbn n1 el PU 11 001 3 .3.6.1.2, 0 pra
andalism Sensor 001 Contact String Contact Person 300 1.3.61.2.1.1.4.0 pra
) EB3201.047.014.003.002 Description_en  String Rittal CMC-TC/PU2 SN 22426 HW V3.01 - SW V2.60 300 1.3.6.1.2.1.1.1.0 pro
@ ["J 050015 0‘54.001 enterpriseQID  String 1.3.6.1.4.1.2606.4 off 1.3.6.1.2.1.1.2.0 pro
| R condition StatusInt oK 10 1.3.6.1.4.1,.2606.4.1.3.0 pra
[ (8§201,050.015.004.003 tampUnit StatusInt Celcius 300 1.3.6.1.4.1.2606.43.1.1.0  pro
[¥] §=§201.050.015.004.005 ) cdeviceStatus  Statusint oK 300 1.3.6.1.4.1,2606.4.2,1.0 pra
Quit StatusInt 1 off 1.3.6.1.4.1,2606.4.5.1.0 pro
TrapEnablel SkatusInt enabled off 1.3.6.1.4,1,2606.4.4.7.2,1.2.1 pro
TrapEnable2 StatusInt disabled off 1.3.6.1.4.1.2606.44.7.2.1.2.2 pro
TrapEnable3 StatusInt disabled off 1.3.6.1.4.1.2606.4.4.7.2.1.2.3 pro
TrapEnables StatusInt disabled off 1.3.6.1.4.1.2606.4.4.7.2.1.2.4 pro
TrapReceiverl  String 10.201.49.47 off 1.3.6.1.4.1.2606.4.4.7.2.1.3.1 pro
TrapRecever2  String 0.0.0.0 off 1.3.6.1.4.1.2606.4,4.7.2.1.3.2 pro
TrapReceiver3  String 0.0.0.0 off 1.3.6.1.4.1.2606.4.4.7.2,1.3.3 pro
TrapReceiverd  String 0.0.0.0 off 1.3.6.1.4.1.2606.4.4.7.2.1.34 pro
» TouUl
4 | i
S @ Febler 1, Warmungen ||[ 4 Meldungen |[ w0k ] [ Abgeschiossen | |
D 1552 1
Name 201.047.014.003.001 Prozess | Eigentimer | Beschraibung | Sw:.si Zaitpunkt | | =
r b 0 System O Trapraceiver is started on port 162 Nore  07.08.2009 08:07:5%
Article Number prater sl b 0 System 0 Trapreceiver is started on port 162 None  07.08.2009 08:06:04
Component Type PULl b 0 System O Trapreceiver is started on port 162 None  07.08.2009 08:06:04
Host 10.201,11.28 b O System O Trapreceiver is started on port 162 Nore  07.08.2009 08:06:04 —
Driver Description Y 0 System O Trapreceiver is started on port 162 None 07.08.2009 D8:06:04
Fal ¥ 0 System O Trapreceiver is siarted on port 162 Norme 07.08.2009 08:06:04
Is Watched - YV 0 System O Trapreceiver is started on port 162 Nore (07.08.2009 08:06:04
Location Y 0 System O Trapreceiver is started on port 162 MNone 07.08.2009 08:06:04
Contact Y 0 System 0 Trapreceiver is started on port 162 None 07.08.2009 08:06:04
Description ¥ 0 System O Trapreceiver is started on port 162 None 07.08.2009 08:06:04
e & 0 System O Trapreceiver is started on port 162 None 07.08.2009 08:06:04 ;I
Skatus:

Fig. 40 Configuration of variables
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The mouse can now be used to select a variable. A right-click opens the
context menu.
= The New variable menu item is not required for the configuration of
Rittal components because RiZone automatically discovers all
variables of the components.
The Edit variable menu item permits the configuration of the automatically
discovered variables of a Rittal component.
The Shift and Ctrl keys can be used to select multiple variables. Only the
selected field is refreshed for a multiple selection. All other fields remain
unchanged.
The following variables can be configured for the configuration:
e Interval
o Group
e Description
¢ Publish (forward the value of the variable to higher-level
management systems if an appropriate interface is activated, such
as the SCOM Management Pack)
To ensure correct operation, no other settings may be changed.
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Ways of entering a variable

Name

Name of the variable

Description

Description of the variable

Type

Float and Statusint are possible as variable type.
Float is used when a (float) numeric value is stored in
the variable, Statusint for status variables.

Important note: The variable type can be selected
only when the variable is created. A subsequent
change is not possible.

Publish

If set, the variable will be passed to the Messaging
Service. The variable can now be fetched via SNMP
by a different system and the variable will be
transferred to the SCOM, if the Management Pack is
activated.

Note:

The number of variables that can be transferred to
the SCOM is limited because of the interface of
the SCOM. A maximum of 100 variables or 10
variables can be transferred to the SCOM when
performance counters or SCOM SDK are used,
respectively!

Interval

Specifies the calculation cycle (in seconds). Off
means that the variable will be calculated once after
the project is uploaded.

Meaning

The meaning of the variable (undefined, state, value,
setting, configuration, service, protected, execute).
"Value" should normally be selected here.

Physical
measurement
quantity

Specifies the measurement quantity of the variable.

Unit

Specifies the unit of the variable.

Display factor

Display factor of the variable

Display format

,ntm
where n specifies the number of digits before the
decimal point and m the number of digits after the
decimal point. Example: ,5:0.00 -> five digits before
the decimal point and two digits after the decimal
point.

Group

Selection of the group of the variable.

The selection of the group affects the group status
variables of the component to which the variable in
the project is assigned. If the variable is assigned to a
group and changes its status, the group status
variable of the higher-level infrastructure component
also changes its status to that of the variable
(Exception: Another variable has already raised the
status of the group status variable to a critical status).
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19 Configuration of the SNMP devices

=0 RiZone Yariablein) andern

|Gesamﬂeistung Schrankreihe |

O > B | | |

Power Rack [CIManitering
Availability Security

Speichern ] l Abbrachen l

Fig. 41 Changing variables

19.2  Configuration of SNMP devices

The SNMP devices are configured in the running project; the logged-in user
must have the appropriate rights. A device is selected in the project tree. A
right-click on the selected component opens the associated context menu.
The Variable menu item can now be selected. The variables list of the
component opens in the RiZone GUI main window.

19.2.1 Component name

The component name is configured by selecting Name and clicking the Set
button. Ensure that the name of the component is not longer than the
maximum character length. Please observe here the operating instructions
of the component used.
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19 Configuration of the SNMP devices

Projekt Bearbeiten = Benichie Administration  Hilfe

Standorte | Gerate [330] Rack02 (PSM) : Variablen &

4 M Rittal-Showroom [¥] Gruppieren  Variable suchen:
I [ Racko1=LcP
4 B PUTILCP (Racko) i} Name Wert Einheit Gewerk
fiLce 22 p
%;m;]: o 14 Location ShowRoom Herborn setzen
Eld z
i Rackoz-& 16  Contact PM Rimatrix & Software Sewzen|
4 3 Rack2 (PSM) 18 Description_en  Rittal CMC-TC/PU2 SN 22417 HW V3.01 - SW V2.90.04
- B Rack02 /O 20 enterpriseQID 1.3.6.1.4.1.2606.4
B Rack02-A 22 condition Ok
B Racko2-B 24 tempUnit Celsius [setzen]
A Rittal PMC 200 - 60kW (3+1 red.)
26 deviceStatus Ok aE|
28 Quit No quit Setzen|
31 TrapEnablel Enabled setzen|
34 TrapEnable2 Enabled setzen|
37 TrapEnable3 Enabled Setzen|
40  TrapEnabled Enabled setzen|
43 TrapReceiverl 10.201.49.41 Setzen|
46 TrapReceiver2 10.201.37.133 Setzen|
49 TrapReceiverd 10.201.37.72 Samﬂ|
52 TrapReceiverd 10.201.37.172 setzen|
774 Service Active Setzen|
¥ Rack021/0
v Rack02-A
~| Rack02-8

[-]Component

D 220
Name Rack02 (PSM)
Model number  7320.100
Component type PUT

[0 address 102014952

Serial number 22417

Location ShowRoem Herbom

Aktuelle Meldungen | Abgeschlossene Meldungen |

Contact PM Rimatrix & Software f
Description Rittal CMC-TC/PLZ SN 22417 H Kategoriefilter auf aktuelle Liste Alle Kategerien von aktueller Liste anzeigen = |Zeitspannefilter auf aktuelle Listi Alle * | O Vorherige Meldungen =
SSi L R Zeitpunkt Zeitraum Prozess Eigentimer  Status Beschreibung =
Hardware version 3.01 - . : |
=] Driver description “  2503.2011 10:21:48 Monitoring 86 None SNMP connection established to 10.201.49.60

M= Rittal CmcTc_PU 73201001 @ 2503.20111021:18 Menitoring 86 None SMMP connection lost to IP 10.201.49.60

\ersion 1_1_0_ T = ¥ 25032011 10:21:06 Menitoring 86 None SNMP connection established to 10.201.49.60

|Supported devices 7320.100 9 2503.2011 10:19:06 > 2 Min. Manitaring 86 None SNMP connection lost to IP 10.201.49.60

1 n » o 5M 9011 1naRSa % 3 A A 28 Nena [INIVES ? hliched t~ 10901 10 &N ¥
Fig. 42 Name of the component
|l
Wert setzen [
Meusr Wert:

Rack0?2 (PSM)
nge: 0 - 4C Zeichen]

Fig. 43 Component name value input
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19 Configuration of the SNMP devices

19.2.2 Location name

The location name is configured by selecting Location and clicking the Set
button. Ensure that the name of the location is not longer than the maximum
character length. Please observe here the operating instructions of the
component used.

Projekt Bearbeiten Ansic Berichte Administration  Hilfe

il

Standorte | Gerate [330] Rack02 (PSM) : Variablen 7 x
« B Rittal-Showroom Gruppieren  Variable suchen:
I [ Racko1+LCP
« B oU T LCP (Racko3) D Name Wert Einheit Gewerk
i LcP 22 12 Name Rack02 (PSM)
i Rackoz-B 16 Contact PM Rimatrix & Software
4 [ Rack02 (PSM) 18 Description en  Rittal CMC-TC/PU2 SN 22417 HW V3.01 - SW V2.90.04
- [ Rack02 /0 20 enterpriseOID 1.3.6.1.41.2606.4
B Racko2-A 22 condition Ok
B8 Rack02-B 24 tempUnit Celsius
A Rittal PMC 200 - 60KW (3+1 red) on S xo =
8 Quit No quit
31 TrapEnablel Enabled
34 TrapEnable2 Enabled
37 TrapEnabled Enabled
40 TrapEnabled Enabled
43 TrapReceiverl 10.201.49.41
46 TrapReceiver 10.201.37.133
49 TrapReceiver3 10.201.37.72
52 TrapReceiverd 10.201.37.172
774 Service Active
v Rack02 /O
v Rack02-A
v Rack02-B

<] Component

230
Name Rack02 (PSM)
Model number  7320.100
Component type PUT

1P address 102014952

Serial number 22417

Location ShowReom Herbom
Contact PM Rimatrix & Saftware f
Fimerroer Rittal CMC-TC/PU2 SN 22417 H| | | | Kategoriefilter auf aktuelle Liste Alle Kategorien von aktueller Liste anzeigen = Zeitspannefilter auf aktuelle List: alle - | © Vorherige Meldungen
Software version 2.90.01

Aktuelle Meldungen | Abgeschiossene Meldungen |

0w

Zeitpunkt £eitraum Prozess bigentimer  Status Beschreibung
Hardware version 3.01
I Driver description © 2503.2011 10:19:06 > 1 Min. Menitoring 86 None SNMP connection lost tc IP 10.20149.60
Name Rittal CmcTc PU 7320100 1/ ||| ¥ 25032011 101850 > 1 Min. Menitaring 8 None SNMP connection established to 10.20149.60
Version 110 T “|l|| @ 25032011 10:1%:00 > 2 Min. Manitoring 86 None SNMP connection lost tc IP 10.201.49.60
Supported devices 7320.100 ¥ 25032011 10:17:38 >3 Min. Menitaring 8 None SNMP connection established to 10.20149.60
a b @A 9502901 101607 ~ A Min e 13 Nona CMIMD cnnnactinn Inct +- 1D 10901 A0 &N M
Fig. 44 Location name
Woert setzen 3y
ocation
Neuer Wert:

ISh owRoom Herborm

[Textldmge: O - 40 Zeichen]

| Setren |

[ Ahhrechen l

Fig. 45 Location name value input
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19 Configuration of the SNMP devices

19.2.3 Contact name

The contact name is configured by selecting Contact and clicking the Set
button. Ensure that the name of the contact is not longer than the maximum
character length. Please observe here the operating instructions of the
component used.

Propsa  Resteten . T PR Barchos  Admensyaion  Hile

Si et [3307] Fachil2 (PSWT ( Wariabdlen Bl &
+ W fmu Soowmem [ Enspeen  Varshls mcter
Bl Rackid LR
o [ 1LCP Racids) n Harre amrt Ernmr etk
e 22 12 Waire Eacai PSR =
B, e et et
[ | - P Rimatein o Sefmare =
# [ AackiC (PSR 18 Desoiphon e Rivial DMC-TOPUR 5H 4ET HW V301 - 5% V2580
E"uﬂ."l'ﬂ M entapiedn 134041200404
i Rackl-A = oondiion o
| mimi 3 mpl Celins
[ ot P 2000 - B0 (101 rmed | G _
X cevioriaha ok
R T Mo qui
X TrapEnabied Enabled
M Tapinbied Enabicd
IT  Trapiaables Ensbiled
40 Trapinabies Enabled
i3 Trapfecesesl IN.29LA541
48 Traplacermel 10137 EE
| 48 Trapiscersei 0B ENT2
[ 232 TrepRecehes WI0LITATZ
74 danis Activn
w RackiQ KO
w BackidA
w RackiQ-B
Aifuels Msghingen | Las Muizmmes |
P Rirraaiv & St 1= — - -
Rottsl CNE-TC/RRZ SN 72417 M| || Ketegan ey sl skt biste Bl Kategmnes von sktules bite arasizan. ™ Zetsgarnafiior aof abtnil Lnis Al * | £ Vurhenige Meihangan z
Zetpune Zensmes Frozess Egeroimer  Stns Bestieung -
@ 250A0i A0l Moniomg 5 Mo SKMF corection imt 1o ¥ L0014 5
& 2503l B Moniamng - Mone LKMP cornecion miskhad o 102004050
9 2503018 BE = 1 Min Meon-torng 8& Mone SHMP cornecion imet 82 W LOOA0 140 60
& JEaINis B4 = 1 Mn Monimrng a5 Hone ShMF cornecton mtaksivhed o 112004050
B TE (7Y T R PR T | PR Ty ar Ao S B s ey Ly T SV Y =
Fig. 46 Contact name
Wert setzen =
Contact

Meuwar Wert:

PM Rimatrix & Softwa

[Textlénge: 0 - A0 Zeichen]

Setzen
Abbrechen |

Fig. 47 Contact name value name
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19 Configuration of the SNMP devices

19.24 Quit

The Quit function permits the automatic acknowledgement of a message and
the confirmation of configuration changes for the CMC-TC system. The Set
button enables and disables the function.

The "Quit", "No quit" and "Restart" functions can be selected.

Quit: The message will be acknowledged.
No quit: The message will not be acknowledged.
Restart: The Processing Unit will be booted.

Please observe here the operating instructions of the component used.

Propa  Bewbedien VI Wt Bariches Admansturtion  Hile
[ e [3300] Fackil2 (P5MY Wariabien 61 =
+ B A Seowmem ¥ Enppmen Varabls ucten
B Auckeci -LCP
[P T LCP (Racki) E IS, - et ol T
f:-.l:.P."J 172 Nam= EakliZ (FRM
o 14 loeation Saambizam Herbam
[ Anckiis 5
B ekl 10 Tonbxi il Rimaiein & Softesare
o B Rackoz peny 18 Desoripmonen  Rittal OMC-TOPUR SHZ2GET HW W01 - 5% 200,04
B Ao 1D M enbepreedD L38.0.4.0.7006.8
[ T cordiion &
| i 2 tamplsa Coluiun [tz
T il PG 300 - B 2+ el ; . . il
X deicaitena D ia
Y - L
H o Tpinabid Enaksled
M Trpgasbiez Enaliled :
T Topiapbled Enahled
40 Tpinabisd Enakzled
3 Tepdsie] 1n200.44.41
46 TrapRacerel L801.37133
I| 49 Trpisesraed M3
[l 12 TopReceves LRILITATR
T4 Sanvice Acineg
v Bk D)
w (ki
v Backli?-B
arra Fackl] (Pl
ol nubar  TEAEA00
o porestl Type AU
[F abress 102014532
rid nimbier  Z24LT ATt Meiths rgen | Abg r
Lo hamfam Hemom i
PR Rt & Sottwere | . |
Fottad M -TC/RUZ SN 22417 H Katmgcried bar sl sktuals Live Al Kategories ~on sidusier Lits smosiger " Isitscermefiier acf akholle Lih Al * | £ ‘¥nrherige Makhengen =
VAN i::’m Zzpuiy Tenmwan Fossy  Egeeimer  Smos Reschiess ‘
arthadre et i —_
e o JNII0LE 1A Mindang | - &Il Mmnm  SHMAP coormction sstablsha = 100LANED
] Montamng =40 Yo SHMY conrecion lonk 1o P L0180 5L
] Menzing £ Monm  SHMF cznrecion ot 1o 19 LO0L4050
L4 =1 M \I:nl:ln? E: Mona Sk conrecton axtabithed o 103001 4050
" . [ 1 i Ry Al s et @5 M SR A s s bt 3 T WY 8 ) =

Fig. 48 Activating the Quit function
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19.2.5 Trap enable 1-4

The Trap enable function is used to activate/deactivate the trap receiver.
The Set button enables and disables the function. Please observe here the
operating instructions of the component used.

Propict  Besdesien  Aeaiiie T Wi

Banches  Admineciartion  Hifle

2 ‘. a - i 'l
Sh-mrhl Gerine [330) Feachil2 (PSRY ¢ Warablen 11 W

+ W e Seowrmom ¥ Gruzpenen  Varshe mcten
B ki Lp RIS . e
+ [0 0LCP fRackiisy B flars st Erian Gauark
it AR EackE (FEMD =]
%ﬂ;ﬁ“ 14 loesimn Sanwkzam Herbom i?_:
ekl 16 Contsd PRl Rimatein & Sodimare | ez
# R Aacki (M) 16 Desopon e Rittel OMC-TOPUR SN Z241T HW V301 - W V208,84
B fackic 10 M enhepiselD (EENERE. V]
B facklen b T T o
R o il Eee
L A % dwicaSisha ok
&t Mo qui
M Topubel Enshiled
Trpiatied Ensbied
40 TapEnabled Enablad
43 TopReeerl 102413541
46 Trapiezeved FES TR RES)
Il 49 Tpdce 1013772
2 Trapmecshest 18I
T4 Sanics Actova
v Rkl WO
- Beackili2-A
v Heackil2-B
At M | Abgmrhizmmns Uaksingee |
soaton
anhect P Rivixtes B2 Softwaie I
seriphin Fattel CMAC-TCJFUZ 5N 22417 W || | Kartegmriwdibar sl wktuaile it Aila Katagoeies von sktuaiiar Links snmmigen | Deitasannaiiter auf aktalle Lat Al = CF derterige Maidsngen =
I 23 Tampasat Tevman Prazr  [geeime  SmEg Testhimap
i © 25033008 L4330 Montams 5 Monm S conecton o 4o 19 L9014 60
Ririat £ Te P 7300000 ||| 1 25003008 L0316 Montamg a5 Monm SHIMP connection mitshished tn 100014055
i e 110 : M| & 250az00s tenss Mznzmg a Mone  SHM connestion fmt s 19 L0140 60
Surportar dhavicas T3HLL00 £ Lond2a7 Monizmns 3 Monm  SKME cornecton etshithed tn 102004050
n v S EOLT M A e ke

Fig. 49 Trap enable function
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19 Configuration of the SNMP devices

19.2.6 Trap receiver 1-4

The Trap receiver function is used to configure the trap receiver. The Set
button is used to configure the IP address of the trap receiver. Please
observe here the operating instructions of the component used.

T —— Gl Barchie  adminswaton  Hile

5i Gerine [3-300) Fschil2 (PS5 | Warigblers K1 M

P [Te— ¥ Grucpanen  Varabis mcsen
ﬂﬂ.ur".d-l.tp A HH L
o P 0 LCP (Rackii) o farm i,
e 17 Kare Backli? (FEMD
%;:’;; 14 Locaiion Shormbicam Harbom
[ a2 16 Contad Pl Rimanyin & Sodtmare
4 [l Aucki {FSM) 16 Destipion_en  Rittsl DMC-TOPUR SHZ2SIT HW 301 - W V208,04
B Aackta o 20 enterpreOD L3804 120004
E::ﬁ-»: 2 condiion ]
£ 4 tmplden Coluiuin
[ At P 200 - G0 (31 rued | . e imia o
2 GQut Mo quit
31 Tmpbubsl Enablad
34 TmpEasbiel Enghiled
3T Topinsbiel Enabiler
40 Trapinabied Enabled
£  Trapisceied 137133 =
Il 49 Toptece: HIE T F)
52 Topteeues 102037172
T Sarvice Active
= Rkl O
- Rkl
= Rackll-B

Kartugrind e sl aktusbs Liske Alls Krlegare= von skbusiler Lks snmsigen. * Tactacanaafitar auf aktoalls Lk Al = | £ ¥arhengs Makdengan z
Zeapunn Teimmum Az Statut _ .

0 2503 154320 = 1hin Monimmng - Mona SKME connacsan et i I 132015 60

& 25038 1346 =1 Min Menitanng a8 Mo SKMP cornecton mdsbidhed o 10201 40.50

0 2500308 058 = 1kn Menianng 88 More SHMP cornactan let i 1 L5080 60

& 2503013 LSA24T = 1Mkn Monitanng a5 LECT SHMP connechon andsbiched o 10 201 40.50 |

-

D6 11 A &

bl mmmeson mrhanbehectin

0 3H 4051 |

Fig. 51 Configuring the trap receiver
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Fig. 52 Entering the IP address of the trap receiver
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19.2.7 Configuring a value
The Set button is used to set a value. Please observe here the operating
instructions of the component used.

"Reone LRIz =
Brojekt  Beacheiben  Aeajchien  Charts  Worklows  Bepehte  Adminksintion  Hible
- e |
Geate [330] RacelZ (PSM) : Vanablen @ x| [83] Tempewature Fack O2: Varistlen © x|
+ M Fittal-Showroom |7 Gruppieren  Wariable suchen: "
B Recii1 -0
+ BPUT LCP Facky) D Name Mot fxghelt_Goyedk
W Lcp 22 M Type Temperatsre sensor M
i LcP 23 ™ Text Temperature Race 02 e
5 Facki-a B Ok o
i rack03 B i i
a E Packl? PSM) ™ Value 4 o 1l
# [ Rackn210 T Sa 4 C | sazam| I
- Leskage Sensar T8 Setbow 0 C |5l=ﬂ|
. SEWamn EF i Sean|
! Semoke Sersor I—"_ |
& rackoz-a 62 Service Active |{sazea|
{4 Rackoz & I'
B Rittal PRAC 200 - 52 (3+1 red)
[l Companent
a3
Temperatue Rack 02
T3HL500
Temperatuwe Sensor
CELSIUS
Mituelle Veidurgen | Abgesciiossere Meigungen |
Kategoriefilter auf alcuelle Liste  Ale Kategonen von akiuelier Liste anzeigen = E |
i n | L |

Fig. 53 Setting values (general)
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20 Replacement of a device

RiZone allows the replacement of a device in the project tree without
changing the configured properties. Ensure that the device type and the
configuration of the devices are identical.
Procedure:
e Selection of the new device
Left-click the device to mark it in the Discovery window.
e Moving the device into the project tree
Drag the device with pressed Alt key to the device to be replaced.
The variables with the same IDs will be transferred. The message
that now appears must be confirmed.

21 Configuring the communications modules

To increase the capability of RiZone for projects with a larger number of IP
nodes (>150 IP nodes), a second communications module can be started on
the server. The configuration options can be reached from the
Administration > Configure communications module menu item.

- KermmunikationsModul-Konfiguration ]
L[l -

[ . .

[ CommunicationModule
[

I

=l CommunicationMaodule
CommunicationModuleZ

IE Active

StartIP| 1 . 1 1 .1

StopIP | 255 . 255 . 255 . 255

Ubernehmen | [ furicksstzen

Fig. 53b Configuring communications modules

1 Tab for Communications module 1 configuration
2 Tab for Communications module 2 configuration

Active The corresponding module is active when the
checkbox is set.

Note: The first communications module is the master
module and cannot be deactivated.

Start IP The start of the IP range that the communications
module queries using the SNMP protocol.
Stop IP The end of the IP range that the communications

module queries using the SNMP protocol.

The communications module 1 is automatically active after the installation of
RiZone.
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To activate the second module, the "active" checkbox must be set for
communications module 2 and the IP range to be queried entered
(Start/Stop IP).

If the second module is activated, a second communications module service
will be started automatically on the server.

Note!
To ensure that all IP addresses are
monitored, enter the monitored address

ranges.
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22 Configuring the database connection

RiZone saves all fetched and calculated data automatically in an SQL
database. The supplied system contains an MS SQL Express database that
fully suffices for smaller projects and permits the saving of data for several
months (depending on the number of IP nodes and type of the IP nodes).
For mid-sized and larger projects with more than 50 IP nodes or for projects
in which mainly SNMP devices are deployed that supply many values (e.qg.
PMC busbars with measurement, LCP, etc.), it is desirable to connect
RiZone to an external database with larger storage capacity.

| Database ]

[ SiosrlEnd =1 DEConfiguration
Server type MSS0QLExpress ¥
Server name local

Instance name  SQLEXPRESS

Database name

User name
Password ssasen
Ok | [ Apply | [ Reset |

Fig. 53c Configuring the database connection

The following parameters can be set in the configurations tab (Fig. 53c):

Server type The server type.

MSSQL Express (default setting, database is
supplied)

MSSQL

Oracle

Server name The name or IP address of the database server
(default: local)

Instance name The name of the database instance (default:
SQLEXPRESS)

Database name The name of the database

User name The user name for the database access. If a
specific user should access the database, the
user name must be entered here

Password Enter the password that belongs to the user
name

If RiZone should access an external MS SQL database (MSSQL option), the
deployed database user (see User name) requires db.creator rights because
RiZone must create the appropriate databases on the server. For further
operation, db.owner rights suffice.
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Note!
When Oracle is deployed, the required
( database entered in the configurations

tab must have been created on the
Oracle database server prior to the
start of RiZone. Otherwise RiZone
cannot establish any connection to the
database.

23 Updating the RiZone driver
The Administration > Update device driver function can be used to update
the RiZone device driver.
If necessary, updated drivers will be made available as DLL file on our
www.rimatrix5.com website or from our support.
To install the driver, proceed as follows:
1. Click Administration > Update device driver in the opened RiZone
client. A file selection window now opens.
2. In the file selection window, change to the folder in which you stored
the DLL file. Select the DLL file and click Open.
3. A window opens with the transfer status. Once the transfer has
completed, click OK to confirm the action.
This completes the update and the driver will be updated.

After a driver has been updated, those devices previously discovered with
the old driver must be rediscovered and moved to the project.

If the transfer status from item 3 reports an error: Note that only DLLs
provided by Rittal are suitable for update. RiZone does not accept other DLL
files.

24 Downloading the log files

The RiZone logs all user and system actions in the appropriate log files.

To download the log files to the local computer, select the Administration >
Download log files function in the view mode of the client.

g Download Logfiles @
Logtypes November, 2010 b
UserAction Su Mo Tu We Th Fr Sa
System
i1 1 2 3 4 & &
7 3 9 10 11 12 13
14 15 16 17 18 19 20
21 22 23 M 26 27
28 29 30 1 2 -
ok || Close

Fig. 563d Downloading the log files
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In the opened selection window, you can select from the calendar the date
for which you want to download the log files.

Furthermore, the UserAction and System selection fields must be used to
specify which log files are wanted.

UserAction
This log file records all actions that the users made (login, mode change, set
commands, etc.).

System
This log file records all actions that the RiZone or RiZone modules have
performed.

After clicking OK to confirm, the selected files are written in txt format in the

C:\Users\useADocuments\Rizone\Logging folder (depending on the system
configuration, the storage location for your own files can differ).
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25 Messaging service (optional)

Provided activated with the licence key (optional), RiZone offers with the
messaging service the capability to transfer not only the status of
components but also individual, published variables to a higher-level network
management system with the SNMP protocol.

The status of a component will be forwarded automatically to the messaging
service.

25.1 Configuring a variable for the messaging service

During the creation or editing of a project, the Publish checkbox can be
activated for the editing of a variable. If this checkbox is activated, the
variable will be passed to the messaging service. To activate the changes,
the changed project must be uploaded to the RiZone server.

25.2 SNMP configuration

The SNMP agent tab is selected in the Administration > Messaging
service menu. The Activate SNMP agent checkbox activates the service
for connection to a network management system.

The Reinitialise SNMP agent checkbox re-establishes the dynamic MIB for
RiZone. This function can be used to delete the OID in the MIB when a
variable is no longer published.

If the MIB is re-established, this can lead to integration incompatibilities of
RiZone in the network management system.

25.2.1 Network

The Network menu can be used to assign the rights for the SNMP access.
The configuration for the Read community and Write community controls
this authorisation. This setting must be identical with that in the management
system. The access from arbitrary management systems can be permitted
when the Read and Write community fields are empty.

25.2.2 MiIB-II

Settings are made in the MIB-1l menu to identify the RiZone server using
SNMP.

SysName: SNMP name of the RiZone server

SysLocation: Location of the RiZone server

SysContact: System officer

2523 Trap

RiZone supports a maximum of two trap recipients. These can be configured
as Trap recipient 1 and Trap recipient 2.
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25.3 Specification of the MIB

Ei--i;) RITTAL-RIZOME-MIB,iso.org.dod.internet
=3 mgrnk
B3 mib-2
[=F- ) swskern

@ sysi_ontact

@ syshlame

@ sysLocation

‘ SysSErvices
[=}- ) private
=) enterprises

- rittal
"—]_‘,i riZone
=) riZoneMibRey

----- W rizoneMibMaiRey
----- W riZoneMibMinRey
----- W rizoneMibCondition
[=F-23 riZoneMaodules
----- riZoneCarestate
----- riZone_areversion
[=-} riZoneProject
----- W rizoneProjecthame
----- ‘ rizoneProjectChangeTime
[=F-i_J riZonestatus
=113 riZoneCampanents

- FH riZoneComponentTable
=+ riZoneiariables
‘ rizonerumberofyariables
ot FE rizonevariablaTable
----- W rizonestatusailability
----- W rizonesStatusConling
----- riZonestatusPower
----- ‘ riZzonestatusMonitoring
----- Wl rizonestatusSecurity
By SNMPy1 TRAPS
“ f projectUpload

- {4 riZoneMumberOfComponents

mgmt.mib-2.system — Data for identifying the computer. In accordance with
the MIB specification, some data can be written. For deviations between the

SNMP agent and the setting dialog, the dialog data is used (to view the

changes in the setting dialog, the dialog must be closed and re-opened).
private.enterprises.rittal.riZone.rizoneMibRev — version details of the

used MIB. Currently 1.0.
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25 Messaging service (optional)

private.enterprises.rittal.riZone.rizoneMibRev.riZoneMibCondition —
status of the complete system

other (1),

ok (2),

degraded (3),

failed (4),

configChanged (5)
private.enterprises.rittal.riZone.rizoneMibRev.riZoneModule — status
and version of the installed RiZone server
private.enterprises.rittal.riZone.rizoneMibRev.riZoneProject — project
name and timestamp of the last change
private.enterprises.rittal.riZone.rizoneMibRev.riZoneStatus — status of
the components and variables contained in RiZone. The overall status of the
project can also be queried specifically. This corresponds to the status of the
uppermost project node.

Component table
All RiZone components are always available in the component list.

| el |ovguenst |ompretion: |ampretTe |coporentbaent | opoestSiotuTnd | ompreriahatvabdity |oopeeentTatistokng | oot | irpmentSstioiong | qopen3tstensiy

{h L egshost  dean 1 am ok i i #m hm
i k] bkl ok il dam 4 i i3 & dhim
ap oy Teshri iz i o o i * o o
44 3 O i #n dam dc dc o sm )
Component Index —table index
Component Id — RiZone ID of the component
Component Name — RiZone component name
Component Type —
removed (1),
domain (2), — row is no longer used
location (3),
building (4),
room (5),
rackrow (6),
rack (7),
device (8), — component represented by a driver (CMC, LCP, DRC, UPS ...
server (9)
Component Parent — ID of the higher-level component in the RiZone
locations tree
Component Status Total — overall status of Availability, Cooling, Power,
Monitoring and Security
Variables table
The variables list contains all variables that have activated the Publish
option in the properties.
8] ] e [ tenyerdire A neby gt 4 A [ l 1
Ik M s wekfied i mn 4 o | 1
b i Hnidodde iy KN nee ot 52 a0 ik, i 1

RiZone
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Note!
The table will be updated when the "Reinitialise

SNMP agent" function has been executed. If the
function is not called, values may remain in the
table that are no longer present in the RiZone
project or should no longer be published.

Variable Index — table index

Variable ID — RiZone ID of the variable

Variable Name — name from the RiZone variable list

Variable Maintenance Group — specifies to which group the status belongs.
This is a bit-coded field.

undefined(1),

cooling(2),

power(4),

rack(8),

monitoring(16),

remoting(32),

availability(64),

security(128)

Variable Unit — specifies the physical measurement unit. This does not
determine the factor (mW, W, KW).

undefined(1),

temperature(2),

current(3),

power(4),

effectivPower(5),

humidity(6),

voltage(7),

energy(8),

frequency(9),

access(10),

leakage(11),

percent(12),

rpm(13),

co2(14),

pue(15),

flow(16),

time(17),

costs(18),

imp(19)

Variable Parent ID — RiZone ID of the component to which the variable is
assigned.

Variable Type — specifies the data type.

number(1),

string(2),

enum(3)

Variable Quality — validity of the measured value.

undefine(1), — value is not yet initialised. This can occur at the restart of the
RiZone server.

good(2), — value is OK.

bad(3), — the value could not be determined (e.g. timeout). These values do
not represent the current status and cannot be used for calculations.
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Variable Value Int — integer value of the variable (type number or enum)
Variable Value String — written out value. For (type = number) the value
taking account of the factors and a point as decimal separator. For (type =
enum) the significance of the value, e.g. Int=4 > String="OK".

Variable Value Unit — measurement unit of the (Int value *
multiplicand/divisor) e.g. (W, kW, mA, °C)

Variable Divisor — divisor of the value (e.g. value = 333 ; divisor = 10 ; unit
= °C gives 33.3°C)

Variable Multiplicand — multiplicand of the value.

Trap

The RiZone MIB integrates a "projectUpload" trap. This is sent for each
upload from a project to the entered trap receiver. The content of the trap
are variables from the tree listed above — sysContact, sysName,
sysLocation, riZoneProjectName, riZoneProjectChangeTime.

FAQs
There is no setting dialog for the SNMP agent.
Check your licence whether the SNMP agent is activated.

No message arrives in RiZone whether the SNMP agent has been
started.

Activate "Activate SNMP agent". You must now receive a message in the
RiZone message list. If not, check whether the Messaging Service is
running. (As of version 1.3, the Messaging Service is a Windows service.)
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26 Update and deinstallation of the RiZone GUI
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26 Update and deinstallation of the RiZone GUI

26.1 Update of the RiZone GUI

The RiZone GUI is updated by the deinstallation and the installation of the
new GUI.

Detailed information is provided in the Installation and Deinstallation sections
of the GUI.

As of RiZone 2.0, an installed Microsoft .Net Framework 4.0 is required for
the operation.

The .Net 4.0 download is available at:
http://www.microsoft.com/download/en/details.aspx?id=17851

26.2 Deinstallation of the RiZone GUI

The RiZone GUI is deinstalled locally from the client PC control panel.
Example Windows XP: The control panel is opened and the Software menu
item selected. Then select the Rittal RiZone GUI program.
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Fig. 54 Deinstallation of the Rizone GUI

Click the Remove button to prepare the deinstallation of RiZone.
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Fig. 55 Deinstallation of the RiZone GUI

The confirmation of the prompt causes the deinstallation to be performed.
A deinstallation under Vista or Windows 7 is performed similarly.
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27 Technical specifications

271 Virtual machine (Software Appliance) technical
specifications

System requirements*

CPU 2 GHz dual core processor
RAM 4 GB

Hard disk capacity 70 GB

Network 1 Gbit SNMP

1 Gbit Fileshare/Management
Supported hypervisors VMWare, Xen, Hyper-V
Client operating system  Windows 2008 Server R2 64-bit
Ports used 161, 162, 800, 3389, 4433, 22222,
22223
* The listed system prerequisites apply to the virtual machine. The
virtualisation environment (hypervisor) must then run on more powerful
hardware with more CPU power / RAM.

27.2 Hardware Appliance technical specifications

CPU 1.86 GHz Xeon dual core processor

RAM 4 GB

Hard disk capacity 2 x 250 GB (RAID 1)

Network 2 x 1 Gbit Ethernet

Operating system Windows 2008 Server R2 64-bit

Ports used 161, 162, 800, 3389, 4433, 22222,
22223
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Schaltschrank-Systeme
Industrial Enclosures

Coffrets et armoires électriques
Kastsystemen
Apparatskapssystem

Armadi per quadri di comando
Sistemas de armarios
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Stromverteilung

Power Distribution
Distribution de courant
Stroomverdeling
Strodmfdrdelning
Distribuzione di corrente
Distribucion de corriente
ST ERLYATA

Elektronik-Autbau-Systeme
Electronic Packaging
Electronique

Electronic Packaging Systems
Electronic Packaging
Contenitori per elettronica
Sislemas para la glectronica
IO X Nwd—VLATA

System-Klimatisierung
Systermn Climate Control
Climatisation
Systeemklimatisering
Systemklimatisering
Soluzioni di climatizzazione
Climatizacion de sistemas
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IT-Solutions

IT Solutions
Solutions IT
IT-Solutions
IT-lésningar
Soluzioni per IT
Soluciones TI
M/Va—irar

Communication Systemns
Communication Systems
Armoires outdoor
Ouidoor-behuizingen
Comrmunication Systams
Soluzioni outdoor
Sistemas de comunicacion
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Rittal GmbH & Co. KG - Postfach 1662 - D-35726 Herborn
Telefon +49(0)2772 505-0 - Telefax +49(0)2772 505-2319 - eMail: info@rittal.de - www.rittal.de
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